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You	can	view	files	and	folders	stored	in	iCloud	Drive	using	a	web	browser.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	an	option	in	the	sidebar,	such	as	Recents	or	Browse.If	you	don’t	see	the	sidebar,	click	.To	open	a	folder,	double-click	it.To	view	a	file,	do	one	of	the	following:Open	it	in	a	new	tab:	Double-click
it.See	a	preview	in	your	current	tab:	Select	it,	click	in	the	top-right	corner,	then	choose	Preview.	If	the	file	doesn’t	have	a	thumbnail,	you	can’t	see	a	preview.Tip:	You	can	also	select	the	file,	then	press	the	Space	bar.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	or	in	the	top-left	corner	(depending	on	your	current
view).Choose	an	option:Grid:	Files	and	folders	are	shown	as	icons	arranged	in	a	grid.List:	Files	and	folders	are	arranged	by	name	in	a	list,	and	other	columns	show	additional	information.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	the	“Sort	by”	menu	in	the	top-right	corner,	then	choose	Date,	Kind,	Name,	or
Size.If	you	don’t	see	the	“Sort	by”	pop-up	menu,	make	sure	you’re	not	viewing	the	Recents	folder.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Select	the	file	or	folder,	click	in	the	top-right	corner,	then	click	Details.The	information	includes	the	file	type,	its	size,	when	it	was	last	modified,	and	where	it’s	stored.	If	the
file	is	shared,	you	can	also	see	who	shared	it.Learn	how	to	use	iCloud	Drive	on	iCloud.com	on	a	phone	or	tablet.	You	can	view	files	and	folders	stored	in	iCloud	Drive	using	a	web	browser.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	an	option	in	the	sidebar,	such	as	Recents	or	Browse.If	you	don’t	see	the	sidebar,
click	.To	open	a	folder,	double-click	it.To	view	a	file,	do	one	of	the	following:Open	it	in	a	new	tab:	Double-click	it.See	a	preview	in	your	current	tab:	Select	it,	click	in	the	top-right	corner,	then	choose	Preview.	If	the	file	doesn’t	have	a	thumbnail,	you	can’t	see	a	preview.Tip:	You	can	also	select	the	file,	then	press	the	Space	bar.Go	to
icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	or	in	the	top-left	corner	(depending	on	your	current	view).Choose	an	option:Grid:	Files	and	folders	are	shown	as	icons	arranged	in	a	grid.List:	Files	and	folders	are	arranged	by	name	in	a	list,	and	other	columns	show	additional	information.Go	to	icloud.com/iclouddrive,	then
sign	in	to	your	Apple	Account	(if	necessary).Click	the	“Sort	by”	menu	in	the	top-right	corner,	then	choose	Date,	Kind,	Name,	or	Size.If	you	don’t	see	the	“Sort	by”	pop-up	menu,	make	sure	you’re	not	viewing	the	Recents	folder.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Select	the	file	or	folder,	click	in	the	top-right
corner,	then	click	Details.The	information	includes	the	file	type,	its	size,	when	it	was	last	modified,	and	where	it’s	stored.	If	the	file	is	shared,	you	can	also	see	who	shared	it.Learn	how	to	use	iCloud	Drive	on	iCloud.com	on	a	phone	or	tablet.	Cloud	storage	and	cloud	computing	service	Apple	iCloudThe	iCloud.com	web	interfaceTypeCloud	serviceLaunch
dateOctober	12,	2011;	13	years	ago	(2011-10-12)StatusActiveMembers~850	million,	as	of	2018[update][1]Pricing	modelFree;	optional	subscription	for	more	storageWebsiteicloud.com	iCloud	is	the	personal	cloud	service	of	Apple	Inc.	Launched	on	October	12,	2011,	iCloud	enables	users	to	store	and	sync	data	across	devices,	including	Apple	Mail,
Apple	Calendar,	Apple	Photos,	Apple	Notes,	contacts,	settings,	backups,	and	files,	to	collaborate	with	other	users,	and	track	assets	through	Find	My.[2]	iCloud's	client	app	is	built	into	iOS,	iPadOS,	watchOS,	tvOS,	macOS,	and	visionOS,	and	is	available	for	Microsoft	Windows.	iCloud	may	additionally	be	accessed	through	a	limited	web	interface.	iCloud
offers	users	5	GB	of	free	storage	which	may	be	upgraded	through	optional	paid	plans	to	up	to	12	TB;[3][4]	all	paid	plans	include	iCloud+	providing	additional	features.[5]	Optional	end-to-end	encryption	has	been	available	since	2022	for	all	iCloud	data,	except	Calendar,	Contacts,	and	Mail,	which	rely	on	legacy	sync	technologies	for	compatibility	with
third-party	apps	(CalDAV,	CardDAV,	IMAP).[6][7]	As	of	2018[update],	the	service	had	an	estimated	850	million	users,	up	from	782	million	users	in	2016.[1][8][9]	iCloud	was	announced	on	May	31,	2011,	in	a	press	release.[10]	On	June	6,	2011,	during	the	WWDC	2011	keynote,	Steve	Jobs	announced	that	iCloud	would	replace	MobileMe,	which	had	been
widely	seen	as	a	"failure",[11]	a	fact	which	Steve	Jobs	acknowledged	during	the	announcement.[12]	iCloud	was	released	on	October	12,	2011,	and	MobileMe	was	discontinued	on	June	30,	2012.	Previous	MobileMe	users	could	keep	their	@mac.com	and	@me.com	email	addresses	as	aliases	to	their	new	@icloud.com	address.	Earlier	versions	included
Back	to	My	Mac,	which	was	previously	part	of	MobileMe.[13]	This	service	allowed	users	to	create	point-to-point	connections	between	computers.	It	was	discontinued	on	July	1,	2019.	iCloud	had	20	million	users	within	a	week	after	launch.[14]	It	received	early	criticism	for	bugs,	especially	with	Core	Data	syncing.[15][16][17]	These	issues	were
addressed	in	iOS	7	and	OS	X	Mavericks.[18][19]	At	launch,	iCloud	was	partly	hosted	on	Amazon	Web	Services	and	Microsoft	Azure.	In	2016,	Apple	replaced	Azure	with	Google	Cloud	Platform.[20]	In	2021,	The	Information	reported	that	Apple	was	storing	8	million	TB	of	data	on	Google's	cloud,	and	was	on	track	to	spend	$300	million	that	year.[21]
Apple	also	operates	its	own	data	centers,	including	one	in	Maiden,	North	Carolina.[22]	In	June	2019,	iCloud	was	introduced	to	Windows	10	via	the	Microsoft	Store.[23]	In	June	2021,	Apple	introduced	iCloud+,	which	added	Private	Relay,	Hide	My	Email	and	Custom	Email	Domain	to	paid	users	of	the	services,	as	well	as	an	unlimited	storage	limit	for
video	from	cameras	added	through	HomeKit	Secure	Video.	In	March	2022,	Apple	settled	a	class-action	lawsuit	alleging	that	it	had	misled	users	by	storing	data	on	non-Apple	servers.[24][25]	iCloud	is	a	free	service,	and	comes	with	5	GB	of	cloud	storage.	Users	can	subscribe	to	iCloud+	for	additional	storage	up	to	2	TB	(or	4	TB	for	users	of	Apple	One
Premier	plan	who	also	buy	an	additional	2	TB	of	storage).	Some	of	iCloud's	features	are	accessible	not	only	through	apps	built	into	iOS,	iPadOS,	watchOS,	tvOS	and	macOS	but	also	on	iCloud.com.	These	include:	iCloud	Mail,	a	free	email	address	(@icloud.com)	which	supports	Push	email,	a	webmail	interface,	and	IMAP	sync	to	third-party	clients;
Contacts	and	calendar	syncing,	and	calendar	sharing	features,	as	well	as	support	for	CardDAV	and	CalDAV;	iCloud	Drive,	a	cloud	storage	and	syncing	feature;	iCloud	Photos,	which	stores	and	syncs	pictures	in	full-resolution;	Pages,	Keynote,	and	Numbers,	allowing	real-time	collaboration	on	both	native	apps	and	the	web;	Notes	and	Reminders	sync,
and	the	ability	to	edit	and	create	notes	and	reminders	on	the	web;	iCloud	Invites,	allowing	the	creation	and	management	of	digital	invitations;	Find	My,	which	lets	users	find	their	Apple	devices	or	other	Find	My-enabled	devices,	and	remotely	erase	lost	Apple	devices;	iCloud	is	also	built-in	as	a	backend	to	many	Apple	apps	and	system	features,	where	it
can	sync	users'	data	and	settings.	This	includes:	Apple	Books	(books,	highlights,	bookmarks	and	annotations);	Apple	Home	(settings	and	paired	devices);	Apple	Music	(with	a	feature	called	iCloud	Music	Library);	Apple	Wallet	(passes	and	credit	cards);	Phone	(call	history);	Safari	(syncing	bookmarks	and	history);	Siri	(settings,	and	past	interactions	with
Siri	and	Dictation)	Third-party	iOS	and	macOS	app	developers	can	implement	iCloud	functionality	in	their	apps	through	the	iCloud	API.[26]	iCloud	allows	users	to	back	up	the	settings	and	data	on	iOS	devices	running	iOS	5	or	later.[27]	Data	backed	up	includes	photos	and	videos	in	the	Camera	Roll,	device	settings,	app	data,	messages	(iMessage,	SMS,
and	MMS),	ringtones,	and	Visual	Voicemails.[28]	Backups	occur	daily	when	the	device	is	locked	and	connected	to	Wi-Fi	and	a	power	source.	In	case	of	a	malfunction	of	any	Apple	device,	during	the	restoration	process,	iCloud	offers	to	restore	all	data	along	with	App	data	only	if	the	device	was	synced	to	iCloud	and	backed	up.	Main	article:	Find	My
Prior	to	iOS	and	iPadOS	13,	Find	my	iPhone	and	Find	My	Friends	stored	data	in	iCloud	before	merging	into	Find	My.	Find	My	enables	users	to	track	the	location	of	iOS,	iPadOS,	macOS,	watchOS	devices,	AirPods,	AirTags	and	a	number	of	supported	third-party	accessories	through	a	connected	iCloud	account.	A	user	can	see	the	device's	approximate
location	on	a	map	(along	with	a	circle	depicting	the	margin	of	error),	display	a	message	and/or	play	a	sound	on	the	device	(even	if	it	is	set	to	silent),	and	remotely	erase	its	contents.[29]	Users	can	also	share	their	GPS	locations	to	others	with	Apple	devices	and	view	the	location	of	others	who	choose	to	share	their	location.	The	Send	Last	Location
feature,	which	utilizes	iCloud,	can	be	optionally	enabled	to	automatically	send	the	location	of	the	device	to	Apple	when	the	battery	is	low.[30]	See	also:	Keychain	(software)	iCloud	Keychain	is	a	password	manager	developed	by	Apple	that	syncs	passwords	across	devices	and	suggests	secure	ones	when	creating	new	accounts.[31]	It	is	integrated	into
Safari,	and	is	accessible	from	other	applications	on	iOS,	iPadOS,	macOS,	and	visionOS.[32]	It	was	announced	at	WWDC	2013,	and	released	in	October	2013	alongside	iOS	7.0.3.[33]	iCloud	Keychain	backups	provide	different	security	guarantees	than	traditional	iCloud	backups.	This	is	because	iCloud	Keychain	uses	"end-to-end	encryption",	meaning
that	iCloud	Keychain	backups	are	designed	so	that	the	provider	does	not	have	access	to	unencrypted	data.	This	is	accomplished	through	the	use	of	a	novel	"key	vault"	design	based	on	a	Hardware	Security	Module	located	in	Apple's	data	centers.[34]	In	iOS	18	and	iPadOS	18,	iCloud	Keychain	was	migrated	from	a	page	in	the	settings	app	to	a
standalone	app,	Passwords.[35]	The	Passwords	app	continues	to	sync	with	iCloud	Keychain	and	the	Keychain	application.	For	other	uses,	see	ITunes	(disambiguation).	iTunes	Match	debuted	on	November	14,	2011.	It	was	initially	available	to	US	users	only.[36]	For	an	annual	fee,	customers	can	scan	and	match	tracks	in	their	iTunes	music	library,
including	tracks	copied	from	CDs	or	other	sources,	with	tracks	in	the	iTunes	Store,	so	customers	do	not	have	to	repurchase	said	tracks.	Customers	may	download	up	to	100,000	tracks	in	256	kbit/s	DRM-free	AAC	file	format	that	matches	tracks	in	any	supported	audio	file	formats	in	customers'	iTunes	libraries,	including	ALAC	and	MP3.	Customers	also
have	the	choice	to	keep	their	original	copies	stored	on	their	computers	or	have	them	replaced	by	copies	from	the	iTunes	Store.[37]	Any	music	not	available	in	the	iTunes	Store	is	uploaded	for	download	onto	customers'	other	supported	devices	and	computers;	doing	this	will	not	take	storage	from	the	customers'	iCloud's	storage	allowance.	Any	such
tracks	stored	in	the	higher	quality	lossless	audio	ALAC,	or	original	uncompressed	PCM	formats,	WAV	and	AIFF,	are	transcoded	to	256	kbit/s	DRM-free	AAC	format	before	uploading	to	the	customers'	iCloud	storage	account,	leaving	the	original	higher	quality	local	files	in	their	original	format.[38]	If	a	user	stops	paying	for	the	iTunes	Match	service,	all
copies	of	the	DRM-free	AAC	iTunes	Store	versions	of	tracks	that	have	already	been	downloaded	onto	any	device	can	be	kept,[39][40]	whether	on	iOS	devices	or	computers.[39]	From	iOS	7	and	OS	X	Mavericks,	the	iTunes	Radio	function	will	be	available	across	devices,	including	integration	with	the	Music	app,	both	on	portable	iOS	devices	and	Apple
TV	(2nd	generation	onwards),	as	well	as	inside	the	iTunes	app	on	Macintosh	and	Windows	computers.	It	will	be	included	in	an	ad-free	version	for	subscribers	to	the	iTunes	Match	service	and	is	currently[when?]	available	only	in	the	US	and	Australia[41]	The	streaming	Genius	shuffle	is	not	available	in	current[when?]	versions	of	iOS	but	is	available	in
iTunes	on	the	Mac.	On	January	28,	2016,	ad-free	iTunes	Radio	was	discontinued	and	is	therefore	no	longer	part	of	iTunes	Match.	As	of	March	26,	2014[update],	iTunes	Match	is	available	in	116	countries,	while	iTunes	in	the	Cloud	is	available	in	155	countries.[42]	Main	article:	iWork	During	the	2013	Apple	Worldwide	Developers	Conference	(WWDC)
keynote	speech,	iWork	for	iCloud	was	announced	for	release	at	the	same	time	as	the	next	version	of	the	app	versions	of	iWork	later	in	the	year.	The	three	apps	for	both	iOS	and	macOS	that	form	Apple's	iWork	suite	(Pages,	Numbers,	and	Keynote),	will	be	made	available	on	a	web	interface	(named	as	Pages	for	iCloud,	Numbers	for	iCloud,	and	Keynote
for	iCloud	respectively),	and	accessed	via	the	iCloud	website	under	each	user's	iCloud	Apple	ID	login.	They	will	also	sync	with	the	user's	iOS	and	macOS	versions	of	the	app,	should	they	have	them,	again	via	their	iCloud	Apple	ID.	This	allows	the	user	to	edit	and	create	documents	on	the	web,	using	one	of	the	supported	browsers:	Safari,	Chrome,	and
Microsoft	Edge.[43]	It	also	means	that	Microsoft	Windows	users	now	have	access	to	these	native	–previously	only	Apple	device–	document	editing	tools,	via	the	web	interface.	Photo	Stream	was	a	service	supplied	with	the	basic	iCloud	service	which	allows	users	to	store	the	most	recent	1,000	photos	on	the	iCloud	servers	for	up	to	30	days	free	of
charge.	When	a	photo	is	taken	on	a	device	with	Photo	Stream	enabled,	it	automatically	uploaded	to	iCloud	servers.	From	there,	it	become	available	for	viewing	and	saving	on	the	rest	of	the	user's	Photo	Stream-enabled	devices.	The	photo	was	automatically	removed	from	the	server	after	30	days	or	when	it	becomes	photo	number	1,001	in	the	user's
stream.	Photo	Stream	installed	on	a	Mac	or	Windows	desktop	computer	includes	an	option	to	have	all	photos	permanently	saved	on	that	device.	The	service	also	integrated	with	Apple	TV,	allowing	users	to	view	their	recent	photos	wirelessly	on	their	HDTV.[44]	In	May	2023,	Apple	announced	the	discontinuation	of	Photo	Stream,	with	uploads	turned
off	on	June	26,	and	the	service	turned	off	on	July	26.[45]	iCloud	Photos	is	a	feature	on	iOS	8.1	or	later	and	OS	X	Yosemite	(version	10.10)	or	later,	plus	web	app	access.	The	service	stores	all	of	the	user's	photos,	maintaining	their	original	resolution	and	metadata.	Users	can	access	their	iCloud	Photos	on	supported	devices	via	the	new	Photos	app	when
available	or	via	the	iCloud	Photos	web	app	at	iCloud.com,	which	helps	limit	the	amount	of	local	storage	each	device	needs	to	use	to	store	photos	(particularly	those	with	smaller	storage	capacities)	by	storing	lower-resolution	versions	on	the	device,	with	the	user	having	the	option	to	keep	some/all	stored	locally	at	a	higher	resolution.	See	also:	Apple	ID
Since	its	introduction	in	2011,	each	account	has	5	GB	of	free	storage	for	owners	of	either	an	iOS	device	using	iOS	5.x	or	later,	or	a	Mac	using	OS	X	Lion	10.7	or	later.	Users	can	pay	monthly	for	additional	storage	for	a	total	of	50	GB,	200	GB	or	2	TB.	Starting	in	September	2023,	storage	options	for	6	TB	and	12	TB	have	been	added.[4]	The	amount	of
storage	is	shared	across	all	devices	per	iCloud	Apple	ID.[46]	Several	native	features	of	iCloud	use	each	user's	iCloud	storage	allowance,	specifically,	Backup	and	restore,	and	email,	Contacts,	and	Calendars.	On	Macs,	users	can	also	store	most	filetypes	into	iCloud	folders	of	their	choosing,	rather	than	only	storing	them	locally	on	the	machine.	While
Photo	Stream	uses	the	iCloud	servers,	usage	does	not	come	out	of	the	user's	iCloud	storage	allowance.	This	is	also	true	for	iTunes	Match	music	content,	even	for	music	that	is	not	sold	in	the	iTunes	Store	and	which	gets	uploaded	into	iCloud	storage,	it	does	not	count	against	the	user's	allowance.	Other	apps	can	optionally	integrate	app	storage	out	of
the	user's	iCloud	storage	allowance.	Not	all	of	a	user's	content	counts	as	part	of	their	iCloud	storage	allowance.	Apple	can	keep	a	permanent	track	of	every	purchase	a	user	makes	under	their	Apple	ID	account,	and	by	associating	each	piece	of	content	with	the	user,	it	means	only	one	copy	of	every	Store	item	is	needed	to	be	kept	on	Apple's	servers.	For
items	bought	from	the	iTunes	Store	(music,	music	videos,	movies,	TV	shows),	Apple	Books	Store	(books),	or	App	Store	(iOS	apps),	this	uses	a	service	Apple	called	iTunes	in	the	Cloud,	allowing	the	user	to	automatically,	or	manually	if	preferred,	re-download	any	of	their	previous	purchases	on	to	a	Mac,	PC,	or	iOS	device.[42]	Downloaded	(or	streamed,
provided	the	user	is	connected	to	the	Internet)	iTunes	Store	content	can	be	used	across	all	these	devices,	however,	while	Apple	Books	Store	and	App	Store	content	can	be	downloaded	to	Macs	and	PCs	for	syncing	to	iOS	devices,	only	iOS	and	Mac	devices	(and	their	respective	apps)	can	be	used	to	read	the	books.[47]	Similarly,	macOS	apps	purchased
from	the	Mac	App	Store	are	also	linked	to	the	Apple	ID	they	were	purchased	through	and	can	be	downloaded	to	any	Mac	using	the	same	Apple	ID.	Also,	when	a	user	registers	any	new	device,	all	previously	bought	Store	content	can	be	downloaded	from	the	Store	servers	or	non-Store	content	from	the	iCloud	servers.[48]	Audiobooks	and	their	metadata
fields	from	non-Apple	purchased	sources	are	not	synced	across	devices	(macOS	or	iOS)	inside	the	Apple	Books	apps,	and	nor	does	the	metadata	from	non-Apple	purchased	books	(in	Ebook	or	PDF	format).	There	remains	a	syncing	mismatch	on	some	types	of	media,	between	Apple-purchased	content	and	non-Apple	purchased	content	that	remains	in
effect	for	iCloud	users.	iCloud	Drive	is	iCloud's	file	hosting	service,	that	syncs	files	across	devices	running	iOS	8,	OS	X	Yosemite	(version	10.10),	or	Windows	7	or	later,	plus	online	web	app	access	via	iCloud.com.	Users	can	store	any	kind	of	file	(including	photos,	videos,	documents,	music,	and	other	apps'	data)	in	iCloud	Drive	and	access	it	on	any	Mac,
iPad,	iPhone,	iPod	Touch,	or	Windows	PC,	with	any	single	file	being	a	maximum	of	50	GB	in	file	size	(earlier	it	was	15	GB).	This	allows	users	to	start	their	work	on	one	device	and	continue	on	another	device.[49]	By	default,	users	still	get	5	GB	of	storage	for	free	as	previously,	but	the	expandable	storage	plans	available	have	increased	in	size	(current
tiers:	50	GB,	200	GB,	and	2	TB),	and	altered	to	monthly	subscription	payment	options	from	the	yearly	ones	offered	under	the	previous	MobileMe	service.	In	iOS	11,	iCloud	Drive	has	been	integrated	into	the	new	Files	app	that	gives	users	access	to	all	their	cloud	and	local	on-device	storage,	which	replaced	the	standalone	iCloud	Drive	app.[50][51]
According	to	computer	scientist	Malcolm	Hall,	certain	file	types	are	automatically	excluded	from	iCloud	Drive	and	will	not	be	uploaded.	These	exclusions	include	Aperture	and	Photos	libraries.[52]	Users	can	also	manually	exclude	files	or	folders	by	appending	.nosync	to	the	end	of	their	filenames.[53]	Messages	on	iCloud	is	a	feature	on	iOS	11.4	and
macOS	High	Sierra	10.13.5	which	keeps	all	of	a	user's	iMessages	and	SMS	texts	stored	in	the	cloud.[54]	iCloud	Private	Relay	enhances	user	privacy	for	Safari	browsing	by	using	a	multi-hop	architecture	to	separate	a	user's	identity	from	their	web	traffic,	ensuring	that	no	single	party,	including	Apple,	can	see	both	who	the	user	is	and	what	they	are
browsing.[55]	The	process	involves	two	separate	internet	relays:	Ingress	Relay	(Apple):	When	a	user	navigates	to	a	website,	their	request	is	encrypted	on	the	device.	The	traffic	is	first	sent	to	a	relay	operated	by	Apple.	This	relay	can	see	the	user's	IP	address	but	not	the	name	of	the	website	they	are	trying	to	visit,	as	the	DNS	query	is	encrypted.[55]
Egress	Relay	(Third-Party):	From	Apple's	relay,	the	request	is	passed	to	a	second	relay	operated	by	a	third-party	content	delivery	network,	such	as	Cloudflare	or	Fastly.	This	egress	relay	can	see	the	destination	website	but	not	the	user's	original	IP	address.	It	assigns	a	temporary	IP	address	before	sending	the	request	to	the	website.[56]	This	dual-relay
design	is	a	practical	implementation	of	a	privacy-preserving	protocol	called	Oblivious	HTTP,	which	is	standardized	by	the	Internet	Engineering	Task	Force.[57]	The	protocol	is	designed	to	decouple	requests	from	their	source,	thus	protecting	the	user's	identity	from	the	destination	server	and	the	content	of	the	request	from	the	network	intermediaries.
According	to	Apple,	"regulatory	reasons"	prevent	the	company	from	launching	Private	Relay	in	China,	Belarus,	Russia,	Colombia,	Egypt,	Kazakhstan,	Saudi	Arabia,	South	Africa,	Turkmenistan,	Uganda,	and	the	Philippines.[58][59][60]	Up	to	5%	of	Wikipedia	editors	globally	could	be	negatively	affected	by	using	Private	Relay,	because	Wikipedia	blocks
ranges	of	IP	addresses	to	combat	page	vandalism.[61]	Hide	My	Email	is	available	to	iCloud+	users	and	allows	users	in	Mail	and	Safari	to	generate	temporary	Apple	email	addresses	which	forward	messages	to	their	main	email	address.[62]	Custom	Email	Domain,	an	iCloud+	feature,	allows	users	to	personalize	their	email	address	with	a	custom	domain
name	and	invite	family	members	to	use	the	same	domain	with	their	iCloud	Mail	accounts.[62]	In	2013,	as	part	of	the	Snowden	revelations,	The	Washington	Post	and	The	Guardian	reported	on	leaked	NSA	documents	which	showed	that	iCloud	was	part	of	the	NSA's	PRISM	surveillance	program,	along	with	other	cloud	services.	According	to	the
documents,	the	NSA	could	access	emails,	chats,	photos	and	videos,	and	stored	files.	The	documents	specifically	stated	that	the	data	was	collected	through	"equipment	installed	at	company-controlled	locations".[63][64]	The	Washington	Post	further	stated	that	Apple,	like	the	other	companies,	was	aware	of	the	program	and	was	a	willing	participant.
Apple	denied	having	ever	heard	of	the	program.[63][65]	In	2014,	some	celebrities'	nude	photos	were	leaked;	these	photos	had	been	synced	to	iCloud	by	the	celebrities'	iPhones.[66][67]	Apple	denied	that	the	hack	was	caused	by	a	security	flaw	in	iCloud,	and	said	that	the	leaks	were	the	result	of	phishing,	a	targeted	attack	in	which	the	celebrities	were
tricked	by	hackers	into	revealing	their	account	passwords.[68][69]	Some	iCloud	data	is	end-to-end	encrypted	by	default.	As	of	January	2022,	these	include:	Apple	Card	transactions,	Health	data,	Home	data,	iCloud	Keychain,	Apple	Maps	favorites,	collections,	and	search	history,	Memoji,	Messages	in	iCloud,	vocabulary	learned	by	the	QuickType
keyboard,	Safari	history,	tab	groups,	and	iCloud	tabs,	Screen	Time,	Siri	information,	Wi-Fi	passwords,	and	W1	and	H1	Bluetooth	keys.[70]	However,	if	iCloud	Backup	is	enabled,	the	encryption	key	for	Messages	in	iCloud	is	part	of	the	backup,	allowing	Apple	to	access	users'	entire	iMessage	history	if	served	with	a	search	warrant.[70]	On	December	7,
2022,	Apple	announced	Advanced	Data	Protection	for	iCloud,	an	option	to	enable	end-to-end	encryption	for	almost	all	iCloud	data	including	Backups,	Notes,	Photos,	and	more.	The	only	data	classes	that	are	ineligible	for	Advanced	Data	Protection	are	Mail,	Contacts,	and	Calendars,	in	order	to	preserve	the	ability	to	sync	third-party	clients	with	IMAP,
CardDAV	or	CalDAV.[71][72]	The	feature	became	available	to	U.S.	customers	on	December	13	with	the	release	of	iOS/iPadOS	16.2	and	macOS	13.1,	and	was	expanded	to	the	rest	of	the	world	on	January	23,	2023,	with	iOS/iPadOS	16.3	and	macOS	13.2.	Users	must	upgrade	to	these	versions	to	be	able	to	enable	the	feature.[7][73]	Apple	prevents	users
from	enabling	Advanced	Data	Protection	from	a	device	that	was	recently	added	to	their	iCloud	account,	in	order	to	prevent	hackers	from	locking	users	out	of	their	files	by	enabling	encryption.[74]	On	7	February	2025,	US	media	reports	revealed	that	Apple	had	received	a	"technical	capability	notice"	under	the	UK's	Investigatory	Powers	Act	2016,
ordering	them	to	break	the	encryption	on	iCloud	backups	using	Advanced	Data	Protection	worldwide.	The	public	disclosure	of	such	orders	is	illegal.[75]	Two	weeks	later,	on	21	February	2025,	an	Apple	spokesperson	told	several	news	outlets	that	Advanced	Data	Protection	would	no	longer	be	available	to	new	users	in	the	UK	and	that	existing	UK	users
would	need	to	disable	this	feature.[76]	In	early	March	2025,	Apple	has	reportedly	made	an	appeal	to	the	Investigatory	Powers	Tribunal.[77]	Apple	started	scanning	images	sent	via	iCloud	Mail	for	child	sexual	abuse	material	in	2019.[78]	On	August	5,	2021,	Apple	confirmed	it	had	planned	to	start	scanning	iCloud	Photos	for	the	same	reason.[79]
However,	after	receiving	a	public	backlash	against	scanning	unencrypted	unuploaded	photos,	Apple	backed	down	from	its	plans	to	scan	iCloud	Photos,	and	canceled	them	altogether	in	December	2022.[80]	In	February	2018,	Apple	announced	that	iCloud	users	in	China	would	have	their	data,	including	encryption	data,	on	servers	called	"Cloud
Guizhou"	(in	Chinese	"云上贵州")	located	in	the	country	to	comply	with	local	regulations.	This	raised	concerns	from	human	rights	activists	who	claim	that	it	may	be	used	to	track	dissidents.[81]	In	response,	CEO	Tim	Cook	stated	that	Apple	encryption	was	"the	same	in	every	country	in	the	world,"	including	China.[82]	On	June	7,	2021,	during	the	WWDC
event,	Apple	announced	that	iCloud's	new	'private	relay'	feature	would	not	work	in	China	for	regulatory	reasons.[83]	Comparison	of	file	hosting	services	Comparison	of	online	backup	services	Comparison	of	online	music	lockers	Remote	backup	service	File	hosting	service	^	a	b	Novet,	Jordan	(February	11,	2018).	"The	case	for	Apple	to	sell	a	version	of
iCloud	for	work".	CNBC.	Archived	from	the	original	on	January	17,	2023.	Retrieved	April	30,	2019.	^	"Apps	and	features	that	use	iCloud".	Apple	Support.	Archived	from	the	original	on	January	17,	2023.	Retrieved	January	6,	2023.	^	"What	you	can	do	with	iCloud	storage".	Apple	Support.	Archived	from	the	original	on	January	17,	2023.	Retrieved
January	6,	2023.	^	a	b	Silberling,	Amanda	(September	12,	2023).	"iCloud+	adds	a	6TB	and	12TB	storage	plan".	TechCrunch.	Retrieved	September	13,	2023.	^	"What	is	iCloud+?".	Apple	Support.	Archived	from	the	original	on	January	17,	2023.	Retrieved	January	6,	2023.	^	Newman,	Lily	Hay.	"Apple	Expands	End-to-End	Encryption	to	iCloud	Backups".
Wired.	ISSN	1059-1028.	Archived	from	the	original	on	January	17,	2023.	Retrieved	December	7,	2022.	^	a	b	"La	version	finale	de	macOS	13.2	est	disponible	avec	plusieurs	fonctions	de	sécurité".	MacGeneration	(in	French).	January	23,	2023.	Retrieved	January	23,	2023.	^	"Apple	Music	passes	11M	subscribers	as	iCloud	hits	782M	users".	February	12,
2016.	Archived	from	the	original	on	April	20,	2016.	Retrieved	April	29,	2016.	^	'"They	Might	Be	Giants"	With	A	Spanish	Accent',	With	Special	Guests	Eddy	Cue	And	Craig	Federighi,	The	talk	show	146	(32:57)	[1]	Archived	January	24,	2019,	at	the	Wayback	Machine	February	12,	2016	^	"Steve	Jobs	to	unveil	'iCloud',	Mac	OS	X	Lion	and	iOS	5	at
WWDC".	The	Guardian.	May	31,	2011.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	Chen,	Brian	X.	"4th	Time	a	Charm	for	Apple?	From	iDisk	to	.Mac	to	MobileMe	to	iCloud".	Wired.	ISSN	1059-1028.	Archived	from	the	original	on	April	27,	2012.	Retrieved	October	26,	2022.	^	"iCloud:	The	Mother	of	All	Halos".
AllThingsD.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	"Transition	from	MobileMe	to	iCloud".	Apple.	October	12,	2011.	Archived	from	the	original	on	July	29,	2012.	Retrieved	October	12,	2011.	^	"Big	mo:	In	one	week,	Apple	iCloud	hits	20M	users;	25M	use	iOS	5".	CNET.	October	17,	2011.	Archived	from	the
original	on	December	24,	2013.	Retrieved	October	18,	2011.	^	Hamburger,	Ellis	(March	26,	2013).	"Apple's	broken	promise:	why	doesn't	iCloud	'just	work'?".	The	Verge.	Archived	from	the	original	on	January	17,	2023.	Retrieved	May	31,	2013.	^	Panzarino,	Matthew	(March	27,	2013).	"A	tale	of	two	iClouds".	The	Next	Web.	Archived	from	the	original
on	January	17,	2023.	Retrieved	May	31,	2013.	^	Richie,	Rene	(April	5,	2013).	"Debug	12:	iCloud	and	Core	Data	sync".	iMore.	Archived	from	the	original	on	January	17,	2023.	Retrieved	July	2,	2013.	^	Gillett,	Nick	(June	25,	2013).	"WWDC	2013:	What's	New	in	Core	Data	and	iCloud".	YouTube.	Apple.	Archived	from	the	original	on	January	17,	2023.
Retrieved	July	2,	2013.	^	Bischoff,	Matthew	(March	1,	2014).	"iCloud	and	Core	Data".	objc.io.	Archived	from	the	original	on	January	17,	2023.	Retrieved	July	6,	2015.	^	"Apple	may	no	longer	be	using	Microsoft's	Azure".	ZDNET.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	"Apple's	Spending	on	Google	Cloud	Storage
On	Track	to	Soar	50%	This	Year".	The	Information.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	"Apple	Maiden	data	center".	The	Register.	June	9,	2011.	Archived	from	the	original	on	January	17,	2023.	Retrieved	February	2,	2013.	^	Sardo,	Giorgio	(June	11,	2019).	"Apple's	all-new	iCloud	for	Windows	app,	now
available	in	the	Microsoft	Store".	Windows	Experience	Blog.	Archived	from	the	original	on	January	17,	2023.	Retrieved	June	12,	2019.	^	Simon,	Michael	(March	25,	2022).	"If	you	pay	for	extra	iCloud	storage,	you	may	have	a	refund	coming".	Macworld.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	Avery,	Dan
(September	7,	2022).	"Apple's	$14.8	Million	iCloud	Settlement:	When	Will	My	Money	Arrive?".	CNET.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	"iCloud	for	Developers".	Apple.	Archived	from	the	original	on	March	4,	2016.	Retrieved	October	27,	2016.	^	"iCloud:	Backup	and	Restore	Overview".	Apple.	February	17,
2014.	Archived	from	the	original	on	April	24,	2013.	Retrieved	October	30,	2012.	^	"What	does	iCloud	back	up?".	Apple.	Archived	from	the	original	on	May	2,	2020.	Retrieved	April	1,	2017.	^	"Apple	-	iCloud	-	Find	your	missing	Apple	device".	Apple.	Archived	from	the	original	on	January	17,	2023.	Retrieved	September	9,	2017.	^	"New	'Send	Last
Location	to	Apple'	Feature	Added	to	Find	My	iPhone	in	iOS	8".	MacRumors.	June	3,	2014.	Archived	from	the	original	on	January	6,	2023.	Retrieved	January	6,	2023.	^	Bohon,	Cory	(February	9,	2017).	"Apple's	iCloud	Keychain:	The	smart	person's	guide".	TechRepublic.	Retrieved	February	15,	2021.	^	"Set	up	iCloud	Keychain".	Apple	Support.
Retrieved	December	1,	2024.	^	Bohon,	Cory	(February	9,	2017).	"Apple's	iCloud	Keychain:	The	smart	person's	guide".	TechRepublic.	Retrieved	December	1,	2024.	^	"Secure	iCloud	Keychain	recovery".	Apple.com.	February	18,	2021.	Archived	from	the	original	on	January	17,	2023.	Retrieved	March	21,	2021.	^	O'Flaherty,	Kate.	"iOS	18	Includes	A
New	Passwords	App:	Here's	How	To	Use	It".	Forbes.	Retrieved	December	1,	2024.	^	"What's	new	in	iTunes".	Apple.	November	14,	2011.	Archived	from	the	original	on	January	17,	2023.	Retrieved	November	14,	2011.	^	"iTunes	Match:	$24.99/Year,	Matches	Ripped	Tunes,	Offers	Them	In	The	Cloud".	MacRumors.	June	6,	2011.	Archived	from	the
original	on	May	1,	2020.	Retrieved	August	30,	2011.	^	"iTunes	Store:	How	to	subscribe	to	iTunes	Match".	Apple.	January	16,	2012.	Archived	from	the	original	on	January	4,	2021.	Retrieved	July	6,	2012.	Songs	encoded	in	ALAC,	WAV,	or	AIFF	will	be	transcoded	to	a	separate	temporary	AAC	256	kbps	file	locally,	prior	to	uploading	to	iCloud.	The
original	files	will	remain	untouched.	^	a	b	"iCloud	Features:	iTunes	in	the	Cloud".	Apple.	November	14,	2011.	Archived	from	the	original	on	January	17,	2023.	Retrieved	November	14,	2011.	^	Caldwell,	Serenity;	Breen,	Chris;	Friedman,	Lex	(November	16,	2011).	"iTunes	Match:	What	you	need	to	know".	Macworld.	IDG.	Archived	from	the	original	on
March	13,	2012.	Retrieved	December	16,	2011.	^	"Apple	-	iTunes	Radio	-	Here	where	your	music	takes	you".	Apple.	Archived	from	the	original	on	June	13,	2013.	Retrieved	June	15,	2013.	^	a	b	"iTunes	in	the	Cloud	and	iTunes	Match	Availability".	Apple.	August	14,	2013.	Archived	from	the	original	on	October	29,	2014.	Retrieved	August	23,	2013.	^
"IWork".	Archived	from	the	original	on	August	14,	2007.	Retrieved	June	14,	2021.	^	"Apple's	iCloud	Connects	People	and	their	Photos".	InfoTrends	InfoBlog.	June	8,	2011.	Archived	from	the	original	on	December	13,	2017.	Retrieved	August	30,	2011.	^	Porter,	Jon	(May	30,	2023).	"Apple's	original	cloud	photo	sync	service	shuts	down	this	summer".
The	Verge.	Retrieved	June	4,	2023.	^	"iCloud	Storage	Pricing".	Apple.	Archived	from	the	original	on	January	17,	2023.	Retrieved	December	15,	2015.	^	"Apple	-	Buy	and	read	books	on	your	Mac	or	iOS	device	with	iBooks".	Archived	from	the	original	on	January	17,	2023.	Retrieved	July	21,	2014.	^	Myslewski,	Rik	(June	6,	2011).	"Apple	opens	iCloud	to
world+dog".	The	Register.	Archived	from	the	original	on	January	17,	2023.	Retrieved	August	30,	2011.	^	"Apple	-	iOS	8	-	iCloud	Drive".	Apple.	June	2,	2014.	Archived	from	the	original	on	September	8,	2014.	Retrieved	June	15,	2014.	^	"iOS	11's	Files	app	FAQ:	Everything	you	need	to	know!".	iMore.	Archived	from	the	original	on	June	25,	2017.
Retrieved	June	26,	2017.	^	"iCloud	in	iOS	11	FAQ:	Everything	you	need	to	know!".	iMore.	Archived	from	the	original	on	June	7,	2017.	Retrieved	June	26,	2017.	^	Hall,	Malcolm	(August	21,	2017).	"How	to	exclude	a	sub	folder	from	iCloud	drive	in	macOS	Sierra?".	Ask	Different.	Retrieved	February	19,	2023.	^	Furno,	Nicolas	(November	5,	2018).
"Astuce	:	empêcher	un	fichier	ou	un	dossier	de	synchroniser	avec	iCloud".	MacGeneration	(in	French).	Retrieved	February	19,	2023.	^	"iCloud".	Apple	(India).	Archived	from	the	original	on	January	17,	2023.	Retrieved	June	26,	2021.	^	a	b	"About	iCloud	Private	Relay".	Apple	Support.	Retrieved	June	8,	2025.	^	"iCloud	Private	Relay	Overview:	Learn
how	Private	Relay	protects	users'	privacy	on	the	internet"	(PDF).	Apple.	December	2021.	Retrieved	June	8,	2025.{{cite	web}}:	CS1	maint:	url-status	(link)	^	Thomson,	M.;	A.	Wood,	C.	(January	2024).	Oblivious	HTTP	(Report).	RFC	Editor.	doi:10.17487/rfc9458.	^	Nellis,	Stephen;	Dave,	Paresh;	Dave,	Paresh	(June	8,	2021).	"Apple's	new	'private	relay'
feature	will	not	be	available	in	China".	Reuters.	Retrieved	June	8,	2025.	^	"iCloud+	Private	Relay	explained:	Don't	call	it	a	VPN".	Macworld.	Archived	from	the	original	on	December	17,	2021.	Retrieved	June	26,	2021.	^	"Apple	Seemingly	Adds	Russia	to	List	of	Countries	Where	iCloud	Private	Relay	Won't	Be	Available".	Macworld.	September	17,	2021.
Archived	from	the	original	on	January	17,	2023.	Retrieved	January	31,	2022.	^	"Apple	iCloud	Private	Relay	-	Meta".	meta.wikimedia.org.	Archived	from	the	original	on	January	17,	2023.	Retrieved	February	26,	2022.	^	a	b	"IOS	15	-	Features".	Archived	from	the	original	on	June	11,	2021.	Retrieved	June	14,	2021.	^	a	b	Gellman,	Barton;	Poitras,	Laura
(June	7,	2013).	"U.S.,	British	intelligence	mining	data	from	nine	U.S.	Internet	companies	in	broad	secret	program".	Washington	Post.	ISSN	0190-8286.	Archived	from	the	original	on	June	23,	2013.	Retrieved	October	26,	2022.	^	Greenwald,	Glenn;	MacAskill,	Ewen	(June	7,	2013).	"NSA	Prism	program	taps	in	to	user	data	of	Apple,	Google	and	others".
the	Guardian.	Archived	from	the	original	on	July	31,	2013.	Retrieved	October	26,	2022.	^	Seifert,	Dan	(June	6,	2013).	"Secret	program	gives	NSA,	FBI	backdoor	access	to	Apple,	Google,	Facebook,	Microsoft	data".	The	Verge.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	McCormick,	Rich	(August	31,	2014).	"Reported
iCloud	hack	leaks	hundreds	of	nude	celebrity	photos".	The	Verge.	Archived	from	the	original	on	January	17,	2023.	Retrieved	September	2,	2014.	^	Seifert,	Dan	(September	1,	2014).	"Apple	'actively	investigating'	and	FBI	'addressing'	alleged	hack	that	revealed	nude	celebrity	photos".	The	Verge.	Archived	from	the	original	on	January	17,	2023.
Retrieved	September	2,	2014.	^	Kastrenakes,	Jacob	(September	2,	2014).	"Apple	denies	iCloud	breach	in	celebrity	nude	photo	hack".	The	Verge.	Retrieved	September	2,	2014.	^	"Tim	Cook	talks	iCloud	phishing	hack".	MacDailyNews.	Archived	from	the	original	on	January	17,	2023.	Retrieved	September	2,	2014.	^	a	b	"iCloud	security	overview".	Apple
Support.	Archived	from	the	original	on	January	17,	2023.	Retrieved	October	26,	2022.	^	Peters,	Jay	(December	7,	2022).	"Apple	is	adding	end-to-end	encryption	to	iCloud	backups".	The	Verge.	Archived	from	the	original	on	January	17,	2023.	Retrieved	December	7,	2022.	^	Sabin,	Sam	(December	7,	2022).	"Apple	will	start	encrypting	users'	iCloud
backups	as	part	of	new	security	offerings".	Axios.	Archived	from	the	original	on	January	17,	2023.	Retrieved	December	7,	2022.	^	Fleishman,	Glenn	(December	28,	2022).	"Advanced	Data	Protection	for	iCloud:	How	to	lock	and	encrypt	your	personal	data".	Macworld.	Retrieved	January	23,	2023.	^	"Expanded	iCloud	Encryption	Can't	Be	Enabled	From
New	Apple	Devices	Right	Away".	MacRumors.	December	9,	2022.	Retrieved	January	23,	2023.	^	Dominic	Preston	(February	7,	2025).	"Apple	ordered	to	open	encrypted	user	accounts	globally	to	UK	spying".	The	Verge.	^	Dominic	Preston	(February	21,	2025).	"Apple	pulls	encryption	feature	from	UK	over	government	spying	demands".	The	Verge.	^
Emma	Roth	(March	4,	2025).	"Apple	reportedly	challenges	the	UK's	secretive	encryption	crackdown".	The	Verge.	^	"Apple	Has	Reportedly	Been	Scanning	Your	iCloud	Mail	for	Child	Abuse	Images	Since	2019".	Gizmodo.	August	23,	2021.	Archived	from	the	original	on	January	17,	2023.	Retrieved	September	3,	2021.	^	"Apple	confirms	it	will	begin
scanning	iCloud	Photos	for	child	abuse	images".	TechChrunch.	August	5,	2021.	Archived	from	the	original	on	January	17,	2023.	Retrieved	September	3,	2021.	^	Newman,	Lily	Hay.	"Apple	Kills	Its	Plan	to	Scan	Your	Photos	for	CSAM.	Here's	What's	Next".	Wired.	ISSN	1059-1028.	Archived	from	the	original	on	January	17,	2023.	Retrieved	January	15,
2023.	^	"Apple	moves	to	store	iCloud	keys	in	China,	raising	human	rights	fears".	Reuters.	February	26,	2018.	Archived	from	the	original	on	January	17,	2023.	Retrieved	December	14,	2018.	^	Hamilton,	Isobel	Asher	(October	3,	2018).	"Tim	Cook	took	a	subtle	swipe	at	Google	over	how	Apple	does	business	in	China".	Business	Insider.	Archived	from	the
original	on	May	20,	2021.	Retrieved	December	14,	2018.	^	Summerbell,	D.	"Apple	Will	Not	Launch	iCloud	Privacy	Feature	in	China".	WavBand	Tech.	Archived	from	the	original	on	January	17,	2023.	Retrieved	June	8,	2021.	iCloud	information	at	Apple	iCloud	Drive	app	on	the	App	Store	(now	merged	into	Files)	Retrieved	from	"	Accessing	iCloud	Drive
on	an	iPhone	is	a	straightforward	process	that	allows	users	to	store	and	manage	files	across	Apple	devices.	The	iCloud	Drive	is	integrated	into	the	Files	app,	which	is	available	starting	from	iOS	11	and	iPadOS	13.	It	can	be	easily	set	up	to	keep	documents	in	sync	and	enable	seamless	file	sharing	with	friends	and	family.	iCloud	Drive	ensures	that	users
can	access	their	content	on	any	device	logged	in	with	the	same	Apple	ID,	whether	it	is	an	iPhone,	iPad,	or	Mac.	To	start	using	iCloud	Drive,	the	user	needs	to	navigate	to	the	settings	on	their	iPhone,	tap	their	Apple	ID,	and	then	select	iCloud.	Within	the	iCloud	settings,	the	user	can	toggle	on	the	iCloud	Drive	option	and	begin	to	use	the	Files	app	for
accessing	and	organizing	their	documents.	The	process	is	intuitive,	making	it	easy	for	individuals	with	limited	technical	expertise	to	take	advantage	of	the	cloud	storage	system.	iCloud	Drive	is	a	seamless	way	to	store,	access,	and	share	files	across	your	Apple	devices.	Here’s	a	step-by-step	guide	on	how	to	use	iCloud	Drive	on	your	iPhone:	Open	the
“Settings”	app	on	your	iPhone.	Tap	on	your	name	(Apple	ID)	at	the	top	of	the	screen.	Select	“iCloud.”	Ensure	the	toggle	next	to	“iCloud	Drive”	is	switched	on	(green).	Locate	the	“Files”	app	on	your	iPhone.	It	has	a	blue	folder	icon.	Tap	to	open	the	app.	In	the	Files	app,	tap	the	“Browse”	tab	at	the	bottom	of	the	screen.	Under	the	“Locations”	section,
you’ll	see	“iCloud	Drive.”	Tap	on	it.	View	Files	and	Folders:	iCloud	Drive	displays	your	files	and	folders	in	a	clear	format.	Tap	on	any	item	to	open	it.	Create	New	Folders:	Tap	the	ellipsis	(…)	icon	at	the	top	right	corner,	then	select	“New	Folder.”	Upload	Files:	Tap	the	ellipsis	(…)	icon,	then	choose	“Upload	File”	and	browse	for	the	file	you	want	to	add
to	iCloud	Drive.	Share	Files:	Tap	and	hold	on	a	file	or	folder,	then	select	“Share”	to	send	it	via	message,	email,	or	other	methods.	Organize	Your	Files:	Creating	folders	within	iCloud	Drive	helps	keep	your	files	structured	and	easy	to	find.	Offline	Access:	Mark	specific	files	as	“Available	Offline”	to	access	them	without	an	internet	connection.
Collaborate:	Share	folders	with	others	to	work	on	documents	together	in	real	time.	FeatureHow	to	Access	on	iPhoneView	files	and	foldersFiles	app	>	Browse	>	iCloud	DriveCreate	a	new	folderFiles	app	>	iCloud	Drive	>	Ellipsis	(…)	>	New	FolderUpload	a	fileFiles	app	>	iCloud	Drive	>	Ellipsis	(…)	>	Upload	FileShare	a	file	or	folderFiles	app	>	iCloud
Drive	>	Tap	and	hold	on	the	item	>	Share	iCloud	Drive	synchronizes	files	across	Apple	devices	It	can	be	enabled	through	the	iPhone’s	Apple	ID	settings	Stored	files	are	accessible	via	the	Files	app	iCloud	Drive	on	iPhone	allows	you	to	store,	view,	and	work	on	files.	You	can	sync	these	files	across	devices	with	the	same	Apple	ID.	To	enable	iCloud	Drive,
open	the	Settings	app	on	your	iPhone	and	tap	your	Apple	ID	at	the	top.	Then,	select	iCloud	and	toggle	iCloud	Drive	to	‘on’.	Your	iPhone	must	have	iOS	11	or	later	to	use	the	Files	app	for	access.	Open	the	Files	app	on	your	iPhone	to	see	your	iCloud	Drive	files.	Tap	Browse	at	the	bottom,	then	select	iCloud	Drive.	Here,	you	can	view	or	select	any	stored
document	or	folder.	In	the	Files	app,	you	can	easily	add,	edit,	or	delete	documents.	To	download	a	file	to	your	device,	simply	select	it	and	choose	Download.	If	you	accidentally	delete	a	file,	you	can	recover	it	from	the	Recently	Deleted	folder	for	up	to	30	days.	To	share	a	file,	select	it,	tap	the	share	icon,	and	choose	how	you	want	to	share.	You	can	also
collaborate	by	sending	an	invite	to	others	to	view	or	edit	your	document.	This	keeps	your	team’s	work	in	sync.	Enjoy	sharper	detail,	more	accurate	color,	lifelike	lighting,	believable	backgrounds,	and	more	with	our	new	model	update.	Your	generated	images	will	be	more	polished	than	ever.See	What's	NewExplore	how	consumers	want	to	see	climate
stories	told	today,	and	what	that	means	for	your	visuals.Download	Our	Latest	VisualGPS	ReportData-backed	trends.	Generative	AI	demos.	Answers	to	your	usage	rights	questions.	Our	original	video	podcast	covers	it	all—now	on	demand.Watch	NowEnjoy	sharper	detail,	more	accurate	color,	lifelike	lighting,	believable	backgrounds,	and	more	with	our
new	model	update.	Your	generated	images	will	be	more	polished	than	ever.See	What's	NewExplore	how	consumers	want	to	see	climate	stories	told	today,	and	what	that	means	for	your	visuals.Download	Our	Latest	VisualGPS	ReportData-backed	trends.	Generative	AI	demos.	Answers	to	your	usage	rights	questions.	Our	original	video	podcast	covers	it
all—now	on	demand.Watch	NowEnjoy	sharper	detail,	more	accurate	color,	lifelike	lighting,	believable	backgrounds,	and	more	with	our	new	model	update.	Your	generated	images	will	be	more	polished	than	ever.See	What's	NewExplore	how	consumers	want	to	see	climate	stories	told	today,	and	what	that	means	for	your	visuals.Download	Our	Latest
VisualGPS	ReportData-backed	trends.	Generative	AI	demos.	Answers	to	your	usage	rights	questions.	Our	original	video	podcast	covers	it	all—now	on	demand.Watch	Now	With	iCloud	Drive,	you	can	save	any	kind	of	file	to	your	iCloud	storage.	But	how	you	access	all	the	files	in	your	iCloud	Drive	storage	changes	depending	on	whether	you're	using	an
iPhone,	a	Mac,	a	Windows	PC,	or	an	Android	device.	We'll	show	you	how	to	access	iCloud	Drive	on	any	device.	With	it,	you	can	edit	documents,	upload	files,	or	free	up	some	iCloud	storage,	no	matter	where	you	are	or	what	device	you're	using.	How	to	Access	iCloud	Drive	Files	on	an	iPhone	or	iPad	On	iOS	or	iPadOS,	it's	easy	to	sync	different	types	of
data	to	iCloud,	from	backups	to	calendar	events	to	photos.	Most	of	these	options	are	built	into	the	operating	system	on	your	device,	which	is	why	you	can	find	your	iCloud	Photos	directly	in	the	Photos	app.	Similarly,	you	can	access	all	your	iCloud	Drive	files	using	the	built-in	Files	app	on	your	iPhone	or	iPad.	Use	the	Files	App	to	View	iCloud	Drive	Files
on	an	iPhone	or	iPad	The	Files	app	is	an	intuitive	file	browser	that	you	can	pair	with	a	range	of	cloud	storage	services,	like	iCloud,	Google	Drive,	or	Dropbox.	You	can	even	use	Files	to	look	at	documents	saved	locally	on	your	device.	To	access	iCloud	Drive	files	in	the	Files	app:	Open	Files	on	your	iPhone	or	iPad.	Head	to	the	Browse	tab	from	the
bottom.	You'll	see	a	list	of	Locations.	Tap	iCloud	Drive	to	view	all	the	files	in	your	iCloud	account.	Tap	a	file	to	download	and	open	it.	Alternatively,	tap	and	hold	on	a	file	to	view	a	popup	menu	with	more	actions,	like	Rename,	Copy,	or	Delete.	Screenshot	taken	by	Dreamchild	Obari.	No	attribution	required.	Screenshot	taken	by	Dreamchild	Obari.	No
attribution	required.	Screenshot	taken	by	Dreamchild	Obari.	No	attribution	required.	How	to	Manage	iCloud	Storage	on	an	iPhone	or	iPad	Whether	you	want	to	clear	out	some	space	or	buy	more	storage,	you	can	manage	your	iCloud	storage	from	the	Settings	on	your	iPhone	or	iPad.	Open	Settings	and	tap	[Your	Name]	at	the	top	of	the	screen,	then	tap
iCloud.	You	can	see	an	overview	of	your	iCloud	storage	usage	at	the	top	of	the	screen.	Tap	Manage	Account	Storage	for	more	details,	then	tap	Buy	More	Storage	or	Change	Storage	Plan	if	you	want	to	get	more	iCloud	storage.	Alternatively,	scroll	through	the	list	and	tap	on	each	app	to	view	the	options	to	delete	its	iCloud	data.	This	deletes	the	app
data	for	every	device	connected	to	your	iCloud	account.	If	iCloud	backups	are	using	up	too	much	of	your	storage,	consider	backing	up	your	iPhone	to	a	computer	instead.	Much	like	on	an	iPhone	or	iPad,	you	need	to	use	various	different	apps	to	access	iCloud	data	on	your	Mac.	Open	the	Photos	app	to	view	your	iCloud	Photos,	open	the	Notes	app	to	see
your	iCloud	Notes,	and	use	Finder	to	access	your	iCloud	Drive	files.	Use	Finder	to	View	iCloud	Drive	Files	on	a	Mac	Finder	is	the	best	way	to	find	and	manage	all	the	files	on	your	Mac	or	iCloud	Drive	storage.	You	can	even	combine	the	two	by	enabling	the	Desktop	&	Documents	Folders	option	in	your	iCloud	Drive	settings	to	sync	those	folders	from
your	Mac	to	iCloud.	To	view	iCloud	Drive	folders	on	your	Mac,	open	a	new	Finder	window	and	select	iCloud	Drive	from	the	sidebar	on	the	left.	If	you	don't	see	an	iCloud	Drive	option,	go	to	Finder	>	Settings	from	the	menu	bar.	Then,	head	to	the	Sidebar	tab	from	the	pop-up	window	and	enable	the	iCloud	Drive	option.	Interact	with	these	files	and
folders	the	same	way	you	would	with	any	other	file	or	folder	on	your	Mac.	How	to	Manage	iCloud	Storage	on	Your	Mac	To	manage	your	iCloud	storage	on	your	Mac,	go	to	System	Settings	>	[Your	Name]	and	select	iCloud.	You	can	see	which	apps	are	linked	to	your	iCloud	account,	as	well	as	a	storage	usage	chart	at	the	bottom	of	the	preferences
window.	Click	the	Manage	button	under	the	storage	breakdown	to	delete	iCloud	data,	buy	more	storage,	or	change	your	iCloud	storage	plan.	To	manage	your	iCloud	storage	on	a	Windows	machine,	you	need	to	download	and	install	iCloud	for	Windows	from	the	Windows	Store.	This	free	software	lets	you	choose	which	apps	to	sync	with	your	PC,	view
your	storage	usage,	and	turn	on	iCloud	Drive	for	File	Explorer.	Use	File	Explorer	to	View	iCloud	Drive	Files	After	installing	iCloud	for	Windows,	sign	in	to	your	Apple	account	and	enable	the	iCloud	Drive	checkbox.	You	may	also	want	to	enable	any	other	apps	you'd	like	to	sync	with	your	PC.	Now,	open	a	new	File	Explorer	window	and	click	iCloud	Drive
from	the	Quick	Access	navigation	menu.	You	should	be	able	to	view,	edit,	download,	or	delete	any	files	in	your	iCloud	Drive	account	the	same	way	you	would	with	other	files	on	your	computer.	If	you	turn	off	iCloud	Drive	in	the	iCloud	for	Windows	app,	it'll	ask	if	you	want	to	delete	iCloud	files	from	your	PC.	This	won't	delete	anything	from	your	iCloud
account.	How	to	Manage	iCloud	Storage	on	a	Windows	PC	Open	iCloud	for	Windows	to	see	a	breakdown	of	your	iCloud	storage	in	the	main	window.	Click	the	Storage	button	to	delete	data	from	your	iCloud	account;	you	can	also	upgrade	your	storage	by	clicking	the	Buy	more	storage	button.	It	isn't	obvious	how	to	access	files	on	your	iCloud	Drive	from
an	Android	device	because	Apple	doesn't	offer	an	app	that	allows	you	to	do	so.	Fortunately,	you	can	still	access	some	of	your	iCloud	content	by	logging	in	to	the	iCloud	website	from	a	browser.	Use	a	Web	Browser	to	Access	iCloud	Open	any	web	browser	on	your	Android	device	and	go	to	iCloud.com	to	log	in	to	your	Apple	ID	account.	After	logging	in	to
your	account,	tap	the	Apps	icon	in	the	top-right	corner,	next	to	your	profile	picture.	To	view	your	iCloud	Drive	files,	just	tap	the	Drive	option.	You	can	then	tap	files	to	preview	them	or	use	the	Select	option	from	the	ellipsis	(...)	menu	at	the	top-right	corner	to	Download,	Move,	Delete,	and	Edit	them.	Return	to	the	main	menu	and	scroll	all	the	way	down
to	the	end	of	the	page	to	see	a	breakdown	of	your	iCloud	space.	Tap	Your	Storage	to	see	more	information.	You	can't	upgrade	your	storage	through	a	browser,	but	hopefully,	Apple	adds	this	functionality	in	the	future.	As	you've	seen,	it's	fairly	easy	to	access	your	iCloud	storage	on	just	about	any	platform	except	for	Android.	Although	you	can	still	open
iCloud	Drive	through	a	web	browser	on	Android,	this	is	much	less	streamlined	than	the	official	Apple	apps	you	can	use	elsewhere.	Apple's	reluctance	to	play	nice	with	Android	devices	doesn't	stop	at	iCloud	Drive.	It's	just	as	awkward	to	sync	photos,	calendars,	notes,	and	other	details	from	iCloud	to	Android	as	well.	iCloud	Drive	is	Apple’s	essential
connection	between	all	your	devices,	Mac,	iPhone,	iPad,	even	your	Windows	PC.	While	the	cost	of	storage	seems	expensive	in	comparison	to	other	online	storage	services,	its	advantage	is	that	it	works	natively	across	all	your	devices.	[	Related:	How	to	use	iCloud	with	Windows	]	You	can	use	it	to	maintain	access	to	all	your	documents	and	other	items
across	your	Apple	devices,	Macs,	iPhones,	and		iPads.	It	also	works	with	Windows	using	an	application.	Better	yet,	it	works	to	ensure	all	your	items	are	up	to	date	across	all	your	devices.	You	need	to	be	running	iOS	13	or	later	or	macOS	Catalina	or	later	on	your	iPhone,	iPad,	or	Mac.	A	PC	must	run	Windows	10	to	access	iCloud	for	Windows.	How
iCloud	Drive	works	You	can	store	documents,	images	and	spreadsheets	using	iCloud	Drive;	you	can	also	keep	files	and	folders	up-to-date	across	devices,	work	on	them,	and	access	these	items	from	anywhere.	On	iOS	devices,	you	access	your	iCloud	Drive	through	the	Files	app.	Open	Files	and	you’ll	find	iCloud	Drive	as	a	location.	Changes	applied	to	a
copy	of	a	file	on	one	device	will	automatically	sync	across	all	your	other	systems.	This	is	a	real	file	system,	so	you	can	create	and	save	items	to	your	own	self-created	folders,	which	is	useful	if	you	work	across	multiple	devices.		If	you	use	iCloud	Drive	across	multiple	Macs	then	changes	made	to	the	Documents	and	Desktop	files	on	both	Macs	will	sync.
The	Mac	you	activate	last	will	create	its	own	folder	for	the	contents	of	its	Documents	and	Desktop,	and	this	will	also	sync.	How	to	set	up	iCloud	Drive	iCloud	Drive	is	automatically	set	up	on	any	current	Apple	device	running	the	latest	operating	system.	(More	information	is	available	here.)	Apple’s	macOS	will	automatically	save	files	saved	to	your
Desktop	and	Documents	folders	to	iCloud,	making	these	files	available	across	all	your	devices.	That’s	useful	but	will	eat	into	your	online	drive	capacity,	particularly	as	(at	5GB)	Apple	still	doesn’t	provide	sufficient	free	drive	space.	Apple	iCloud	Drive	lets	you	open,	edit,	and	sync	documents	and	files	across	devices.	You	can	buy	more	storage	if	you	like,
or	disable	the	feature	in	System	Preferences>iCloud>iCloud	Drive	Options	–	Uncheck	Desktop	&	Documents	folders	at	the	top	of	the	list.	You	can	store	any	file	format	on	iCloud	Drive	with	an	upper	limit	of	50GB.	Hint:	iCloud	Drive	will	sync	data	using	your	mobile	connection	unless	you	tell	it	not	to	do	so.	That’s	fine	if	you	can	afford	the	data,	but
(particularly)	if	you	travel	abroad,	you	may	want	to	disable	this.	To	do	so,	open	Settings>Cellular	Data>	iCloud	Drive	and	toggle	‘Mobile	Data’	to	Off	(it’s	Green	–	On	–	by	default).	Online	and	on	device	If	you	use	Desktop	&	Documents	then	you	will	find	everything	you	file	there	on	iCloud	Drive	or	via	the	Files	app	on	your	Mac	or	iOS	device.	You	can
also	access	these	files	online	through	your	account	at	www.icloud.com,	which	means	these	files	can	easily	be	edited	on	a	Windows	PC.	iCloud	for	Windows	Apple	offers	iCloud	for	Windows,	an	application	that	makes	photos,	videos,	mail,	files,	and	bookmarks	accessible	on	both	your	Windows	PC	and	iOS	devices.	Any	changes	you	make	on	these	files	on
any	device,	online,	or	Windows	or	Mac,	will	be	replicated	across	your	other	devices.		There’s	a	more	detailed	explanation	of	iCloud	for	Windows	here.	Hint:	You	can	also	access	these	files	from	some	Macs	running	older	operating	systems.	Open	a	new	Finder	menu,	click	the	Go	menu	item	and	select	iCloud	Drive.	If	you	work	on	files,	don’t	forget	to
manually	save	those	changes	to	the	iCloud	Drive,	as	they	will	not	save	automatically	as	they	do	on	macOS.	IDG	Files	and	folders	can	be	shared	in	iCloud	Drive.	How	to	share	files	and	folders	with	iCloud	Drive	Taking	a	lead	from	Dropbox,	you	can	share	and	collaborate	on	specific	files	and	entire	folders	of	documents,	images,	and	other	items	using
iCloud	Drive.	When	you	share	an	item	with	someone	this	way,	they	will	receive	a	link	that	lets	them	access	the	original	file	—	and	if	you	move	that	file,	they	no	longer	have	access.	Here	is	how	to	share	an	item	with	others	using	iCloud	Drive:	Touch	and	hold	the	folder	or	file;	Tap	Share	and	then	choose	Add	People;	You	then	choose	your	share	options
and	how	you	want	to	share	the	item.	There	are	four	different	share	options	when	you	share	items	from	iCloud	Drive.	You	also	choose	how	to	send	the	person(s)	a	link	to	the	folder	or	file	once	the	required	share	option	is	created:	Allow	only	invitees	to	view	and	edit	the	contents:	Tap	Share	followed	by	“Only	people	you	invite,”	and	“Can	make	changes.”	
Allow	only	invitees	to	view	the	contents:	Choose	“Only	people	you	invite,”	and	“View	only,”	to	set	this	up.	Allow	anyone	with	the	link	to	view	and	edit	the	contents:	The	least	secure	choice	is	to	choose	“Anyone	with	the	link,”	and	“Can	make	changes.”	Allow	anyone	with	the	link	to	view	the	contents:	Select	“Anyone	with	the	link,”	and	“View	only,”	if	you
want	everyone	to	see	the	item.	Once	you	begin	sharing	something,	you	can	add	other	people	to	the	share.	If	you	own	a	shared	file	or	folder,	you	can	change	the	access	choices	for	one	person	or	all	the	people	concerned	retrospectively.	To	do	so,	select	the	item,	tap	Share,	and	then	choose	Show	People.	Microsoft	You	can	also	choose	specific	folders
and	files	to	download.	How	to	get	more	iCloud	storage	You	begin	with	a	miserly	5GB	of	free	storage,	which	is	swiftly	consumed	if	you	make	use	of	multiple	devices,	forcing	most	users	to	upgrade	to	a	different	storage	plan.	Before	you	do	upgrade,	make	sure	to	follow	this	advice	on	how	to	get	the	best	possible	use	of	the	free	storage	allocation	Apple
provides.	But	once	you	do	decide	to	invest	in	a	different	plan,	the	easiest	way	to	do	so	is	to	open	iCloud	in	your	Settings	or	System	Preferences.	There	you	should	see	an	item	called	iCloud	Storage,	which	will	show	you	the	current	state	of	your	storage.	For	most	people,	a	huge	chunk	of	space	is	used	by	Photos	and	videos.		To	switch	to	a	different
storage	plan,	tap	Manage	and	then	choose	Buy	More	Storage.	Or	tap	Downgrade	Options	if	you	want	to	reduce	your	storage.	Storage	is	available	in	5G	(free),	50GB	(99	cents/month),	200GB	($2.99/month)	and	2TB	($9.99/month).	You	can	also	get	storage	included	within	your	Apple	One	plan.	iCloud	Drive	FAQs	Controlling	apps:	Many	third-party	apps
want	to	use	iCloud	Drive	to	store	their	own	data.	This	is	useful	for	some	apps	you	plan	to	use	across	all	your	systems,	but	may	not	always	be	what	you	want.	To	control	which	apps	can	store	data	to	your	online	drive:	On	iOS:	Open	Settings>iCloud>	and	switch	any	app	you	don’t	want	accessing	your	drive	off	(toggle	to	white).	On	Mac:	System
Preferences>Apple	ID>iCloud	Drive>	choose	Options	and	uncheck	the	apps	you	don’t	want	to	support.	Time	Zones:	If	you	notice	that	emails	and	calendar	entries	have	begun	showing	the	wrong	time	zones	its	possible	your	account	settings	are	incorrect.	To	check,	login	to	your	account	online	at	www.icloud.com	and	tap	Settings.	At	the	top	of	the	next
page,	you	should	see	Time	Zone/Region,	which	should	state	where	you	are.	If	it	doesn’t,	you	can	change	this	and	the	time	zone	problem	will	be	resolved	across	all	your	devices.	Reclaim	deleted	files:	If	you	accidentally	delete	something	stored	on	iCloud	Drive,	you	can	easily	get	it	back	again	from	iCloud.com.	All	you	need	to	do	is	login	to	the	account,
check	Settings>Advanced	and	click	Restore	Files.	Wait	a	few	moments	and	you	will	be	presented	with	a	list	of	files	that	you	have	previously	deleted	in	the	Restore	Files	window.	Tick	the	box	beside	the	file(s)	you	want	to	restore	and	tap	Done.	Files	are	only	available	in	this	way	for	30-days.	Version	conflict:	If	you	have	files	open	on	two	devices	at	once,
modifications	made	on	one	device	may	be	out	of	sync.	iCloud	Drive	should	warn	you	when	this	kind	of	version	conflict	takes	place.	When	it	does,	you	can	double-click	a	version’s	thumbnail	to	see	its	contents,	and	delete	the	other	one.	How	to	sync	fast:	You	may	sometimes	find	files	aren’t	syncing	across	your	devices	as	swiftly	as	you	want.	You	can
force	sync	some	iCloud	apps	by	turning	your	device	off	and	switching	it	on	again,	though	there	are	several	additional	approaches	available.	Find	out	more	on	how	to	synchronize	iCloud	—	and	what	to	do	when	it	won’t	sync.	What	about	Android?	You	can	access	some	iCloud	features	(Photos,	Notes,	Reminders,	and	Find	iPhone)	using	the	Android
browser.	Learn	more	about	iCloud:	Got	a	story?	Drop	me	a	line	via	Twitter.	Follow	me	there	so	I	can	let	you	know	when	fresh	items	are	published	here	on	Computerworld.	When	you	set	up	iCloud	Drive	in	iCloud	for	Windows,	you	can	work	with	your	iCloud	Drive	files	and	folders	directly	on	your	Windows	computer	in	File	Explorer	or	Windows
Explorer.If	you	can’t	open	a	file,	it	might	have	been	created	using	an	app	you	don’t	have	on	your	computer.Note:	In	iCloud	for	Windows	version	7,	all	files	in	iCloud	Drive	are	automatically	downloaded	to	your	computer.On	your	Windows	computer,	open	File	Explorer	or	Windows	Explorer,	then	click	iCloud	Drive	in	the	Navigation	pane.Drag	files	to
iCloud	Drive.You	can	access	these	files	on	all	your	devices	that	have	iCloud	Drive	turned	on.	See	Set	up	iCloud	Drive	on	all	your	devices	in	the	iCloud	User	Guide.Note:	Some	apps,	like	Pages,	Numbers,	and	Keynote,	have	their	own	folders	in	iCloud	Drive.	You	can	only	upload	a	file	into	an	app’s	folder	if	the	app	can	open	the	file.On	your	Windows
computer,	open	File	Explorer	or	Windows	Explorer,	then	click	iCloud	Drive	in	the	Navigation	pane.Locate	the	items	you	want	to	remove.Drag	the	items	from	iCloud	Drive	to	the	desktop	or	another	folder	on	your	hard	disk.The	items	are	moved	to	your	Windows	computer	and	removed	from	iCloud	Drive	on	all	your	devices	that	have	iCloud	Drive	turned



on.	If	you	change	your	mind,	you	can	drag	the	items	back	to	iCloud	Drive.	Accessing	your	files	stored	in	iCloud	is	a	breeze,	once	you	understand	the	various	methods	Apple	provides.	The	core	answer	is	this:	you	can	access	your	iCloud	files	via	the	iCloud	website,	the	Files	app	on	your	iOS	and	iPadOS	devices,	the	Finder	on	your	Mac,	and	through
iCloud	Drive	on	your	Windows	PC.	Each	method	offers	a	slightly	different	user	experience,	so	let’s	delve	into	the	details.Accessing	iCloud	Files:	A	Detailed	WalkthroughThrough	the	iCloud	Website:	Your	Universal	Access	PointThe	iCloud	website	(icloud.com)	is	your	go-to	solution	for	accessing	your	files	from	any	device	with	a	web	browser.	It’s
platform-agnostic,	meaning	it	works	equally	well	on	a	Windows	PC,	an	Android	phone,	or	even	a	Linux	machine.Open	your	web	browser	and	navigate	to	icloud.com.Sign	in	using	your	Apple	ID	and	password.	You	may	also	be	prompted	for	two-factor	authentication,	if	enabled.Once	logged	in,	you’ll	see	a	dashboard	of	iCloud	services.	Click	on	“iCloud
Drive”	to	access	your	files.Here,	you	can	browse,	download,	upload,	and	even	delete	files.	You	can	also	open	compatible	files	directly	in	your	browser	(e.g.,	Pages	documents,	Numbers	spreadsheets,	Keynote	presentations).To	download	a	file,	simply	select	it	and	click	the	download	icon	(usually	a	cloud	with	a	downward-pointing	arrow).To	upload	a	file,
click	the	upload	icon	(usually	a	cloud	with	an	upward-pointing	arrow)	and	select	the	file	from	your	computer.You	can	also	create	new	folders	to	organize	your	files	more	effectively.The	iCloud	website	is	particularly	useful	when	you’re	on	a	device	that	doesn’t	have	iCloud	Drive	installed,	or	when	you	need	to	access	your	files	quickly	without
downloading	any	software.Using	the	Files	App	on	iOS	and	iPadOS:	Seamless	IntegrationFor	users	of	iPhones	and	iPads,	the	Files	app	provides	deep	integration	with	iCloud	Drive.	It’s	a	central	hub	for	all	your	files,	whether	they’re	stored	locally	on	your	device,	in	iCloud,	or	on	other	cloud	storage	services	you’ve	connected.Open	the	Files	app.	It’s
usually	pre-installed	on	your	device.	If	you	can’t	find	it,	search	for	it	in	the	App	Library.In	the	Files	app,	you’ll	see	different	locations	listed,	including	“iCloud	Drive”.	Tap	on	“iCloud	Drive”	to	access	your	iCloud	files.You	can	now	browse	your	files	and	folders	as	you	would	on	any	other	file	system.To	open	a	file,	simply	tap	on	it.	The	Files	app	will
automatically	open	the	file	in	the	appropriate	app.To	upload	a	file,	you	can	use	the	share	sheet	from	within	an	app.	For	example,	if	you’re	in	the	Photos	app,	you	can	select	a	photo,	tap	the	share	button,	and	choose	“Save	to	Files.”	Then,	select	iCloud	Drive	as	the	location.You	can	also	create	new	folders	by	pressing	and	holding	in	a	blank	area	and
selecting	“New	Folder”.The	Files	app	is	exceptionally	convenient	for	managing	your	iCloud	files	on	the	go.	Its	tight	integration	with	iOS	and	iPadOS	makes	it	a	natural	and	intuitive	choice.Accessing	iCloud	Drive	on	Your	Mac:	Finder	IntegrationOn	macOS,	iCloud	Drive	is	directly	integrated	into	the	Finder.	This	means	your	iCloud	files	appear	alongside
your	local	files,	creating	a	seamless	and	unified	file	system.Open	the	Finder.	It’s	the	icon	that	looks	like	a	smiling	face	in	your	Dock.In	the	Finder	sidebar,	you	should	see	“iCloud	Drive”	listed.	If	you	don’t	see	it,	go	to	Finder	Preferences	(Finder	>	Preferences)	and	make	sure	“iCloud	Drive”	is	checked	in	the	sidebar	settings.Click	on	“iCloud	Drive”	to
access	your	files.You	can	now	browse,	open,	edit,	move,	and	delete	files	just	like	you	would	with	any	other	file	on	your	Mac.To	upload	a	file,	simply	drag	and	drop	it	into	the	iCloud	Drive	folder.Any	changes	you	make	to	files	in	iCloud	Drive	on	your	Mac	will	automatically	sync	to	iCloud	and	across	all	your	other	devices.The	Finder	integration	is
arguably	the	most	convenient	way	to	access	iCloud	files	for	Mac	users.	It’s	deeply	ingrained	in	the	macOS	experience,	making	it	feel	like	a	natural	extension	of	your	local	file	system.iCloud	for	Windows:	Bridging	the	GapFor	Windows	users,	Apple	provides	iCloud	for	Windows,	a	free	application	that	synchronizes	your	iCloud	files,	photos,	mail,
contacts,	and	calendars	with	your	PC.Download	iCloud	for	Windows	from	the	Microsoft	Store	or	the	Apple	website.Install	iCloud	for	Windows	and	follow	the	on-screen	instructions.Sign	in	with	your	Apple	ID	and	password.Choose	which	iCloud	features	you	want	to	sync,	including	“iCloud	Drive”.Once	setup	is	complete,	a	dedicated	iCloud	Drive	folder
will	be	created	in	your	File	Explorer.You	can	now	access,	edit,	and	manage	your	iCloud	files	directly	from	this	folder.Any	changes	you	make	to	files	in	the	iCloud	Drive	folder	on	your	PC	will	automatically	sync	to	iCloud	and	across	all	your	other	devices.iCloud	for	Windows	is	essential	for	Windows	users	who	want	to	seamlessly	integrate	their	iCloud
files	and	other	data	with	their	PC.	It	allows	you	to	stay	productive	and	connected,	regardless	of	the	operating	system	you’re	using.Frequently	Asked	Questions	(FAQs)1.	How	do	I	enable	iCloud	Drive	on	my	devices?On	iOS	and	iPadOS:	Go	to	Settings	>	[Your	Name]	>	iCloud.	Make	sure	the	“iCloud	Drive”	toggle	is	turned	on.	On	macOS:	Go	to	System
Settings	(or	System	Preferences)	>	[Your	Name]	>	iCloud.	Ensure	“iCloud	Drive”	is	selected.2.	What	types	of	files	can	I	store	in	iCloud	Drive?You	can	store	almost	any	type	of	file	in	iCloud	Drive,	including	documents,	photos,	videos,	music,	and	app	data.	However,	some	files	may	be	subject	to	size	limitations	depending	on	your	iCloud	storage	plan.3.
How	much	free	storage	do	I	get	with	iCloud?Apple	provides	5GB	of	free	iCloud	storage	to	every	user.	If	you	need	more	storage,	you	can	upgrade	to	a	paid	iCloud+	plan.4.	How	do	I	upgrade	my	iCloud	storage?On	iOS	and	iPadOS:	Go	to	Settings	>	[Your	Name]	>	iCloud	>	Manage	Account	Storage	>	Change	Storage	Plan.	On	macOS:	Go	to	System
Settings	(or	System	Preferences)	>	[Your	Name]	>	iCloud	>	Manage.5.	How	do	I	share	files	and	folders	in	iCloud	Drive	with	others?Select	the	file	or	folder	you	want	to	share,	then	click	the	share	icon	(usually	a	square	with	an	upward-pointing	arrow).	Choose	“Share	Link”	and	select	the	desired	permissions	(e.g.,	“Anyone	with	the	link”	or	“Only	people
you	invite”).	You	can	then	send	the	link	to	others.6.	Can	I	access	iCloud	files	offline?Yes,	you	can	access	iCloud	files	offline.	On	iOS,	iPadOS,	and	macOS,	iCloud	Drive	automatically	downloads	frequently	used	files	to	your	device	for	offline	access.	You	can	also	manually	download	files	for	offline	use	by	tapping	the	download	icon	next	to	the	file	name.7.
How	do	I	delete	files	from	iCloud	Drive?You	can	delete	files	from	iCloud	Drive	in	the	same	way	you	would	delete	files	from	any	other	file	system.	Select	the	file	and	drag	it	to	the	Trash/Recycle	Bin,	or	right-click	and	choose	“Delete”.	Remember	that	deleting	a	file	from	iCloud	Drive	will	remove	it	from	all	your	devices.8.	What	happens	if	I	run	out	of
iCloud	storage?If	you	run	out	of	iCloud	storage,	your	devices	may	stop	backing	up,	and	you	may	not	be	able	to	sync	new	files	to	iCloud	Drive.	You’ll	also	receive	notifications	prompting	you	to	upgrade	your	storage	plan.9.	How	do	I	troubleshoot	iCloud	Drive	syncing	issues?If	you’re	experiencing	syncing	issues,	first	make	sure	you	have	a	stable	internet
connection.	Then,	check	that	iCloud	Drive	is	enabled	on	all	your	devices	and	that	you’re	signed	in	with	the	same	Apple	ID.	You	can	also	try	restarting	your	devices	or	contacting	Apple	Support	for	assistance.10.	Is	iCloud	Drive	secure?Apple	uses	encryption	to	protect	your	iCloud	data	both	in	transit	and	at	rest.	They	also	employ	various	security
measures	to	prevent	unauthorized	access.	However,	it’s	always	a	good	idea	to	use	strong	passwords	and	enable	two-factor	authentication	to	further	protect	your	account.11.	Can	I	use	iCloud	Drive	to	back	up	my	entire	computer?While	iCloud	Drive	is	great	for	storing	files	and	documents,	it’s	not	designed	to	be	a	full-system	backup	solution.	For
complete	backups	of	your	computer,	consider	using	Time	Machine	(on	macOS)	or	a	dedicated	backup	service.12.	How	do	I	stop	syncing	a	specific	folder	to	iCloud	Drive?On	macOS:	Locate	the	folder	in	Finder,	right-click,	and	select	“Remove	Download”.	This	removes	the	local	copy	and	stops	syncing,	but	the	folder	remains	in	iCloud.	Deleting	the	folder
from	iCloud	will	remove	it	everywhere.	You	can’t	selectively	stop	sync	in	the	same	way	on	iOS	or	iPadOS,	but	you	can	delete	the	folder	entirely	from	iCloud	Drive.	You	can	view	files	and	folders	stored	in	iCloud	Drive	using	a	web	browser.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	an	option	in	the	sidebar,	such
as	Recents	or	Browse.If	you	don’t	see	the	sidebar,	click	.To	open	a	folder,	double-click	it.To	view	a	file,	do	one	of	the	following:Open	it	in	a	new	tab:	Double-click	it.See	a	preview	in	your	current	tab:	Select	it,	click	in	the	top-right	corner,	then	choose	Preview.	If	the	file	doesn’t	have	a	thumbnail,	you	can’t	see	a	preview.Tip:	You	can	also	select	the	file,
then	press	the	Space	bar.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	or	in	the	top-left	corner	(depending	on	your	current	view).Choose	an	option:Grid:	Files	and	folders	are	shown	as	icons	arranged	in	a	grid.List:	Files	and	folders	are	arranged	by	name	in	a	list,	and	other	columns	show	additional	information.Go
to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	the	“Sort	by”	menu	in	the	top-right	corner,	then	choose	Date,	Kind,	Name,	or	Size.If	you	don’t	see	the	“Sort	by”	pop-up	menu,	make	sure	you’re	not	viewing	the	Recents	folder.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Select	the	file
or	folder,	click	in	the	top-right	corner,	then	click	Details.The	information	includes	the	file	type,	its	size,	when	it	was	last	modified,	and	where	it’s	stored.	If	the	file	is	shared,	you	can	also	see	who	shared	it.Learn	how	to	use	iCloud	Drive	on	iCloud.com	on	a	phone	or	tablet.	/>	You	can	access	your	files,	photos,	mail,	notes,	and	other	data	on	any	device	by
signing	in	to	.	Once	you	enable	iCloud	syncing	on	your	Mac,	you	can	view	photos	in	the	Photos	app,	and	your	iCloud	Drive	files	in	Finder.	If	you	modify	or	delete	a	file	on	iCloud	from	one	of	your	devices,	the	change	will	take	effect	everywhere	you	use	iCloud.	1	Open	the	Files	app	on	your	iPhone	or	iPad.	You	can	use	the	Files	app	to	access	any	of	the
files	you've	saved	to	your	iCloud	Drive.	You'll	find	Files	on	the	Home	screen,	in	the	App	Library,	or	by	searching.[1]	If	you're	looking	for	your	iCloud	Photos,	you'll	find	them	in	the	Photos	app.	If	you	haven't	already	set	up	iCloud	syncing	on	your	iPhone	or	iPad,	see	this	method.	2	Tap	Browse.	You'll	see	this	option	at	the	bottom	of	Files.	This	tapes	you
to	the	Browse	screen.[2]	Advertisement	3	Tap	iCloud	Drive.	It'll	be	at	the	top	of	the	folder	list	under	"Locations."	This	displays	all	of	the	files	and	folders	you've	saved	to	your	iCloud	Drive.	Advertisement	1	Open	Finder	on	your	Mac	.	It's	the	two-toned	smiley	face	icon	on	the	Dock.[3]	To	see	the	photos	you've	synced	to	iCloud	from	other	devices,	just
open	the	Photos	app	on	your	Mac.	2	Click	iCloud	Drive	in	the	left	panel.	This	displays	all	of	the	files	and	folders	you've	saved	to	your	iCloud	Drive.[4]	If	you	don't	see	iCloud	Drive,	see	this	method	to	set	up	iCloud	syncing	on	your	Mac.	You	can	also	access	your	iCloud	Drive	files	in	a	terminal	using	Linux	commands.	Advertisement	1	Go	to	the	in	your
web	browser	and	click	Sign	In.	If	you	want	an	easy	way	to	access	your	iCloud	Photos,	Mail,	and	other	data	while	you're	away	from	your	primary	Mac,	iPhone,	or	iPad,	you'll	love	iCloud	on	the	web.	You	can	sign	in	to	the	web-based	version	of	iCloud	from	any	device—even	your	Android	or	Windows	PC.[5]	If	you're	using	Windows,	you	can	opt	to	install
the	iCloud	for	Windows	app	from	the	Microsoft	Store	if	you	want	to	automatically	sync	files	to	and	from	your	PC	instead.	See	this	wikiHow	guide	to	learn	how!	If	you	just	want	to	access	your	iCloud	files	and	don't	want	to	sync,	accessing	on	the	web	is	the	simplest	way	to	get	to	your	files,	as	well	as	upload	new	ones.	2	Enter	your	Apple	ID	and	password
to	sign	in.	To	access	your	iCloud	information,	you'll	need	to	sign	into	your	account.[6]	After	entering	your	email	address,	click	the	arrow,	then	enter	your	password	to	sign	in.	3	Confirm	your	identity	with	two-step	authentication.	If	two-step	authentication	is	enabled	on	your	account,	you	will	receive	a	code	on	your	primary	device,	which	could	be	your
iPhone,	iPad,	or	Mac.	Tap	or	click	the	notification	you	receive	on	your	primary	device,	then	tap	Allow	to	see	the	code.	Type	the	code	into	the	field	in	your	web	browser	to	sign	in.	Click	Trust	if	you're	using	your	own	personal	device	and	want	to	give	it	permission	to	access	iCloud.	4	Access	your	photos	in	the	Photos	app.	You'll	see	the	Photos	app	icon
near	the	bottom-left	corner	of	the	main	iCloud	page,	as	well	as	in	the	menu	at	the	top-right	corner.	Now	you	can	see	all	of	the	photos	you've	synced	to	from	your	devices,	including	your	iPhone	or	iPad.[7]	5	Access	your	iCloud	email	in	the	Mail	app.	If	you	want	to	check	your	iCloud	email	when	you're	away	from	your	iPhone,	iPad,	or	Mac,	you	can	do	so
in	the	Mail	app	on	iCloud.	Just	click	Mail	at	the	top	of	the	page,	or	click	the	menu	icon	at	the	top-right	and	choose	the	Mail	app	to	access	your	inbox.[8]	6	Access	your	iCloud	Drive	files	in	the	Drive	app.	Any	files	you've	synced	to	your	iCloud	Drive	from	other	devices	will	be	available	in	the	Drive	app	on	this	page.	You	can	also	add	new	files	to	iCloud
Drive	here.	Click	and	drag	any	documents	you	wish	to	save	onto	the	Drive	screen.	Now	your	documents	will	be	available	from	any	synced	device,	including	an	iPhone	or	iPad.	7	Access	other	data	on	iCloud.	Click	the	menu	icon	at	the	top-right	to	explore	all	of	the	different	apps	and	files	you	can	work	with	using	iCloud	on	the	web.	You	can	view	and
manage	your	Calendar,	access	your	Contacts,	see	and	create	Reminders,	and	even	use	web-based	versions	of	apps	like	Pages,	Numbers,	and	Keynote.[9]	Advertisement	1	Open	your	iPhone	or	iPad's	Settings.	You'll	find	it	on	your	Home	screen	or	in	your	App	Library.	Once	you	enable	iCloud	syncing	in	iOS,	you	can	easily	access	all	of	your	iCloud	Drive
files,	iCloud	Photos,	and	other	synced	data.[10]	2	Tap	your	name.	It's	at	the	top	of	the	menu.[11]	If	you	are	not	signed	in,	tap	Sign	in	to	(Your	Device),	enter	your	Apple	ID	and	password,	then	tap	Sign	In.	3	Tap	iCloud.	It's	in	the	second	section.[12]	4	Select	the	types	of	data	you	wish	to	store	on	iCloud.	Enabling	iCloud	for	these	apps	and	data	types
ensures	you'll	have	access	to	the	same	files	anywhere	you	sign	in	with	your	Apple	ID.	To	sync	your	photos,	tap	Photos,	and	then	tap	the	"Sync	this	iPhone"	(or	"Sync	this	iPad")	switch.	Syncing	your	photos	makes	all	of	the	photos	on	your	iPhone	or	iPad	available	anywhere	you	sign	in	to	iCloud,	including	your	Mac,	PC,	and	on	the	web.	To	keep	the	files
on	your	iPhone	or	iPad	synced	to	your	iCloud	Drive	so	you	can	access	them	anywhere,	tap	iCloud	Drive,	and	then	tap	Sync	this	iPhone	(or	Sync	this	iPad).	This	option	also	makes	it	possible	to	access	your	iCloud	Drive	files	in	the	Files	app.	To	use	your	iCloud	email	address	in	the	Mail	app,	tap	iCloud	Mail,	and	then	enable	"Use	on	this	iPhone"	(or	iPad).
To	keep	your	passwords	synced	across	your	devices,	tap	Passwords	and	Keychain,	and	then	tap	"Sync	this	iPhone"	(or	iPad).	You	can	tap	Show	All	to	see	additional	apps	and	data	types	capable	of	syncing	to	iCloud.	5	Scroll	down	and	tap	iCloud	Backup	to	back	up	your	iPhone	or	iPad	to	iCloud.	It's	in	the	"DEVICE	BACKUPS"	section.	If	you	don't	see
this	option,	tap	<	iCloud	at	the	top-left	to	go	back	one	screen.	To	set	up	automatic	backups	to	iCloud,	tap	the	switch	next	to	"Back	Up	This	iPhone"	(or	iPad).	To	start	your	first	backup,	tap	Back	Up	Now.	Advertisement	1	Open	your	Mac's	System	Preferences.	You'll	find	this	option	in	the	Apple	menu	at	the	top-left	corner.	Once	you	enable	iCloud
syncing,	you'll	be	able	to	access	your	iCloud	data,	including	photos	and	files	in	your	iCloud	Drive,	on	your	Mac.	2	Click	Apple	ID.	It's	near	the	top	of	the	window.[13]	If	you	see	Sign	In,	click	that	option	and	log	in	with	your	Apple	ID.[14]	3	Click	iCloud.	You'll	see	this	option	in	the	left	panel.	Now	you'll	see	the	option	to	enable	or	disable	iCloud	Drive,	as
well	as	turn	on	iCloud	for	other	apps	and	data	on	your	Mac.[15]	4	Check	the	box	next	to	"iCloud	Drive"	to	sync	the	files	on	your	iCloud	Drive	to	and	from	your	Mac.	Once	you've	enabled	this	feature,	all	of	your	files	in	iCloud	will	sync	to	your	Mac,	which	allows	you	to	access	them	in	Finder.[16]	To	view	your	iCloud	Drive	files	on	your	Mac,	open	Finder,
then	click	the	iCloud	Drive	option	in	the	left	panel.	5	Click	Options	to	choose	which	files	to	sync	to	your	iCloud	Drive.	This	button	is	to	the	right	of	"iCloud	Drive"	at	the	top	of	the	window.[17]	6	Select	files	to	sync	to	your	iCloud	Drive.	Syncing	files	automatically	to	your	iCloud	Drive	is	a	great	way	to	keep	your	important	files	safely	stored	in	the	cloud.
If	you	want	the	files	you	save	to	your	Mac's	desktop	and	your	Documents	folder	to	stay	synced	to	iCloud	so	you	can	access	them	anywhere,	check	the	box	next	to	"Desktop	&	Documents	Folders."	Scroll	down	to	view	all	apps	and	data	that	you	can	sync	to	iCloud.	Checking	the	box	next	to	these	apps	and	data	types	ensures	they'll	stay	synced.	Click	Done
when	you're	finished.	7	Choose	which	other	types	of	data	to	sync	to	iCloud.	In	the	"Apps	on	this	Mac	using	iCloud"	section,	check	the	boxes	next	to	each	type	of	data	you	want	to	keep	synced	to	iCloud.	This	includes	Calendar,	Mail,	Contacts,	and	even	your	Safari	data.	To	sync	the	photos	on	your	Mac	to	iCloud,	check	the	box	next	to	"Photos."	This	also
syncs	iCloud	photos	from	your	other	devices	to	your	Mac	so	they'll	be	available	in	the	Photos	app.	Most	options	are	selected	by	default	to	ensure	a	seamless	experience	across	all	of	your	devices.	8	Access	your	iCloud	files.	Now	that	you've	enabled	iCloud,	it's	easy	to	find	your	files:	Advertisement	Add	New	Question	Question	How	do	I	set	up	iCloud	on
my	phone?	Josef	Storzi	Apple	&	Mobile	Phone	Repair	Specialist	Josef	Storzi	is	an	Apple	and	Mobile	Phone	Repair	Specialist	and	the	Owner	of	Imobile	LA,	a	mobile	phone	repair	company	based	in	Los	Angeles,	California.	Josef	specializes	in	repairing	screens,	charging	ports,	batteries,	water	damage,	speakers,	and	microphones	on	all	mobile	phone
brands	including	Apple,	Samsung,	LG,	Nokia,	and	Sony.	He	also	specializes	in	tablet,	laptop,	and	computer	repairs	as	well	as	the	pros	and	cons	of	recent	mobile	software	updates.	On	an	iDevice,	there's	a	section	for	iCloud	in	your	Settings	menu.	Here,	you	can	see	all	the	data	that's	being	synced	and	backed	up.	It	also	gives	you	the	option	to	turn
individual	items	on	or	off.	Question	How	do	I	get	to	iCloud	on	a	PC?	Josef	Storzi	Apple	&	Mobile	Phone	Repair	Specialist	Josef	Storzi	is	an	Apple	and	Mobile	Phone	Repair	Specialist	and	the	Owner	of	Imobile	LA,	a	mobile	phone	repair	company	based	in	Los	Angeles,	California.	Josef	specializes	in	repairing	screens,	charging	ports,	batteries,	water
damage,	speakers,	and	microphones	on	all	mobile	phone	brands	including	Apple,	Samsung,	LG,	Nokia,	and	Sony.	He	also	specializes	in	tablet,	laptop,	and	computer	repairs	as	well	as	the	pros	and	cons	of	recent	mobile	software	updates.	Navigate	to	iCloud.com	in	your	browser	and	sign	into	your	iCloud	account.	From	there,	you'll	see	all	of	the	data
from	your	iDevice	that	has	been	synced	to	iCloud.	Question	How	do	I	take	photos	off	of	iCloud?	Sign	into	your	iCloud	and	go	to	"Photos."	Click	"Select,"	then	click	on	the	photos	you	don't	want	anymore.	Once	oyu	have	them	selected,	click	"Delete."	Alternatively,	you	could	also	delete	the	photos	one	by	one	if	the	select	option	is	not	there	See	more
answers	Ask	a	Question	Advertisement	Thanks	Thanks	Thanks	The	advice	in	this	section	is	based	on	the	lived	experiences	of	wikiHow	readers	like	you.	If	you	have	a	helpful	tip	you’d	like	to	share	on	wikiHow,	please	submit	it	in	the	field	below.	When	your	iCloud	storage	starts	filling	up,	check	your	Settings	to	see	what's	taking	up	the	most	space	and
delete	any	old	files	you	don't	need	anymore.	Use	another	backup	service	like	Google	Drive	or	Dropbox	in	addition	to	iCloud	so	you	have	multiple	copies	of	your	files.	Advertisement	Co-authored	by:	Apple	&	Mobile	Phone	Repair	Specialist	This	article	was	co-authored	by	Josef	Storzi	and	by	wikiHow	staff	writer,	Nicole	Levine,	MFA.	Josef	Storzi	is	an
Apple	and	Mobile	Phone	Repair	Specialist	and	the	Owner	of	Imobile	LA,	a	mobile	phone	repair	company	based	in	Los	Angeles,	California.	Josef	specializes	in	repairing	screens,	charging	ports,	batteries,	water	damage,	speakers,	and	microphones	on	all	mobile	phone	brands	including	Apple,	Samsung,	LG,	Nokia,	and	Sony.	He	also	specializes	in	tablet,
laptop,	and	computer	repairs	as	well	as	the	pros	and	cons	of	recent	mobile	software	updates.	This	article	has	been	viewed	2,297,843	times.	Co-authors:	38	Updated:	December	18,	2024	Views:	2,297,843	Categories:	Featured	Articles	|	Apple	iOS	|	ICloud	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read
2,297,843	times.	Share	—	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,
provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—
You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of
the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	You	can	view	files	and	folders	stored	in	iCloud	Drive	using	a	web	browser.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	an	option	in	the	sidebar,	such	as
Recents	or	Browse.If	you	don’t	see	the	sidebar,	click	.To	open	a	folder,	double-click	it.To	view	a	file,	do	one	of	the	following:Open	it	in	a	new	tab:	Double-click	it.See	a	preview	in	your	current	tab:	Select	it,	click	in	the	top-right	corner,	then	choose	Preview.	If	the	file	doesn’t	have	a	thumbnail,	you	can’t	see	a	preview.Tip:	You	can	also	select	the	file,	then
press	the	Space	bar.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	or	in	the	top-left	corner	(depending	on	your	current	view).Choose	an	option:Grid:	Files	and	folders	are	shown	as	icons	arranged	in	a	grid.List:	Files	and	folders	are	arranged	by	name	in	a	list,	and	other	columns	show	additional	information.Go	to
icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	the	“Sort	by”	menu	in	the	top-right	corner,	then	choose	Date,	Kind,	Name,	or	Size.If	you	don’t	see	the	“Sort	by”	pop-up	menu,	make	sure	you’re	not	viewing	the	Recents	folder.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Select	the	file	or
folder,	click	in	the	top-right	corner,	then	click	Details.The	information	includes	the	file	type,	its	size,	when	it	was	last	modified,	and	where	it’s	stored.	If	the	file	is	shared,	you	can	also	see	who	shared	it.Learn	how	to	use	iCloud	Drive	on	iCloud.com	on	a	phone	or	tablet.	Download	Article	Free	up	space	in	your	iCloud	Drive	by	deleting	unwanted	photos,
files,	messages,	and	more	Download	Article	If	your	iCloud	storage	is	full	and	you	don't	want	to	pay	for	more	space,	you	can	delete	items	using	your	computer,	iPhone,	iPad,	or	Apple	Vision	Pro.	Deleting	files,	folders,	and	messages	from	iCloud	deletes	them	everywhere	you	use	your	Apple	ID	and	have	iCloud	Drive	turned	on.	This	wikiHow	will	teach
you	how	to	delete	items	from	iCloud,	including	photos,	files,	and	folders	in	your	iCloud	Drive	and	messages	and	attachments	in	Messages.	If	you	have	iCloud	syncing	activated	for	an	app,	such	as	Photos	or	Files,	you	can	delete	items	from	iCloud	by	deleting	them	in	the	app.	Deleted	items	are	typically	stored	in	a	Recently	Deleted	folder	for	30	days.
Deleting	items	from	iCloud	will	delete	them	across	all	your	linked	devices.	Back	up	anything	you	want	to	keep	to	local	storage.	1	On	an	iOS	Device.	You	can	delete	folders	and	files	on	iCloud	directly	from	your	Files	app	on	iPhone,	iPad,	or	Apple	Vision	Pro.	The	process	varies	slightly	depending	on	which	device	you’re	using.[1]	Open	the	Files	app,
which	looks	like	a	blue	file	folder.	On	an	iPhone,	tap	the	Browse	tab.	On	an	iPad	or	Apple	Vision	Pro,	open	the	Sidebar.	Tap	iCloud	Drive	under	Locations.	On	an	iPhone,	tap	the	•••	More	button	in	the	top	right	corner	of	the	screen,	then	tap	Select.	On	an	iPad	or	Apple	Vision	Pro,	just	tap	Select.	Tap	any	folders	or	files	you	want	to	delete.	A	checkmark
will	appear	in	the	circle	at	the	center	of	the	icon.	Tap	the	Delete	button	at	the	bottom	of	the	screen.	It	looks	like	a	trash	can.	2	On	a	Mac.	You	can	delete	files	and	folders	from	iCloud	on	a	Mac	using	the	Finder.	Open	Finder	and	click	iCloud	Drive	in	the	left	sidebar.	Drag	any	files	or	folders	you	want	to	delete	into	the	Trash.	If	you’d	rather	save	them
locally	to	your	Mac,	simply	drag	them	to	a	local	folder.	Advertisement	3	On	a	Windows	PC.	Launch	the	iCloud	for	Windows	app.	If	you	don’t	have	it	already,	download	it	from	the	Microsoft	Store.	Then:	Sign	in	with	your	Apple	ID.	Make	sure	iCloud	Drive	is	turned	on	in	the	app.	Then,	open	the	iCloud	Drive	folder.	Select	any	folders	or	files	you	want	to
delete	and	click	Delete.	4	On	iCloud	for	the	web.	Visit	in	a	browser	on	your	computer	or	mobile	device.	If	you’re	not	already	logged	in,	click	the	Sign	In	button	and	do	so	now.	From	there:	Click	the	iCloud	Drive	app	icon.	It	looks	like	a	blue	cloud.	Click	Browse	in	the	sidebar	to	see	all	your	files	and	folders.	Click	any	files	or	folders	you	want	to	delete	to
select	them.	You	can	also	Shift-click,	Control-click	(Windows),	or	Command-click	(Mac)	to	select	multiple	files	at	once.	Click	the	Delete	icon	(it	looks	like	a	trash	can)	in	the	top	right	corner	of	the	page.	5	Recover	accidentally	deleted	files	from	Recently	Deleted.	If	you	deleted	any	files	or	folders	that	you	want	to	keep,	you	have	30	days	to	recover	them
from	your	Recently	Deleted	folder.	Open	this	folder	in	the	iCloud	Drive	app	for	iOS	or	Windows,	or	in	Drive	on	iCloud.com,	and	select	any	deleted	items	you	want	to	recover.	Click	Recover	to	move	them	out	of	Recently	Deleted.	If	you	want	to	throw	any	items	away	permanently	before	the	30	days	are	up,	select	them	and	click	Delete	instead.
Advertisement	1	On	iOS	devices.	If	you	have	iCloud	Photos	turned	on,	deleting	photos	from	iCloud	is	as	simple	as	deleting	them	from	the	Photos	app	on	your	device.	Back	up	any	photos	you	want	to	keep	first,	since	this	process	will	delete	them	from	iCloud	and	any	other	devices	where	you	have	iCloud	enabled.[2]	On	your	iPhone,	iPad,	or	Apple	Vision
Pro,	open	the	Photos	app.	Tap	Library	>	All	Photos	at	the	bottom	of	the	screen.	Tap	Select	in	the	top	right	corner.	Tap	any	photos	you	want	to	delete.	Tap	the	Delete	button	(it	looks	like	a	trash	can)	at	the	bottom	right	corner	of	the	screen.	Tap	Delete	Photo	to	confirm.	If	you	don’t	have	iCloud	Photos	activated	on	your	phone,	they	may	still	be	stored	in
iCloud	as	part	of	your	iCloud	Backup.	On	your	device,	go	to	Settings	>	[your	name]	>	iCloud	and	select	Manage	Storage	Account	or	Manage	Storage,	then	tap	Backups.	Select	your	device	name	and	choose	Photos	to	view	and	delete	photos.	You	won’t	see	this	option	if	you	have	iCloud	Photos	turned	on.	2	On	a	Mac.	The	process	for	deleting	photos	from
iCloud	on	a	Mac	is	very	similar	to	doing	it	on	an	iOS	device.	Again,	if	you	want	to	keep	any	of	these	photos	in	another	location,	back	them	up	to	a	local	folder	on	your	Mac,	to	another	cloud	service,	or	to	an	external	storage	device	first.	Open	the	Photos	app	on	your	Mac.	Click	on	any	photos	or	videos	you	want	to	delete.	Use	Shift-click	to	select	multiple
photos	in	a	row,	or	Command-click	to	select	non-consecutive	photos.	Control-click	one	of	your	selected	photos	and	choose	Delete	[number]	Photos.	You	can	also	press	the	Delete	key	after	selecting	your	images.	Click	Delete	again	to	confirm.	3	On	iCloud	for	the	web.	You	can	use	this	method	from	any	device,	including	Android	devices	and	Windows
computers.	Save	any	photos	you	want	to	keep	before	doing	this,	since	it	will	delete	them	from	any	devices	logged	into	your	iCloud	account.	Go	to	in	a	browser	on	your	mobile	device	or	computer.	If	you’re	not	already	logged	in,	click	the	Sign	In	button	and	do	so	now.	Click	the	Photos	app	icon.	You	may	need	to	scroll	down	to	find	it.	Click	any	photos	or
videos	you	want	to	delete	to	select	them.	You	can	select	multiple	images	with	Shift-click,	Command-click	(Mac),	or	Control-click	(PC),	or	by	using	the	Select	button	in	a	mobile	browser	on	iOS.	Tap	the	Delete	button	in	the	top	right	corner.	It	looks	like	a	trash	can.	Tap	Delete	again	to	confirm.	4	Recover	your	photos	from	the	Recently	Deleted	album.	If
you	accidentally	deleted	any	photos	or	videos	you	want	to	keep,	don’t	worry!	You	can	recover	them	for	up	to	30	days.	Go	to	the	Recently	Deleted	folder	in	the	Photos	app	on	your	iOS	device,	Mac,	or	iCloud.com.	Select	any	photos	you	want	to	save	and	tap	or	click	Recover.	You	can	also	delete	images	permanently	from	this	folder	to	free	up	space	in	your
iCloud	account	more	quickly.	Advertisement	1	On	iOS	Devices.	Open	the	Messages	app	on	your	iPhone,	iPad,	or	Apple	Vision	Pro.	If	you	have	iCloud	for	Messages	set	up	on	your	device,	you	can	remove	messages	from	the	cloud	directly	from	the	Messages	app.[3]	To	delete	an	individual	message	or	attachment,	open	the	conversation	and	tap	and	hold
the	text	bubble	or	attachment	you	want	to	delete.	Tap	More,	then	tap	the	Delete	button	(it	looks	like	a	trash	can).	Tap	Delete	Message	to	confirm.	To	delete	a	whole	conversation,	swipe	left	on	it	and	tap	Delete.	Tap	Delete	again	to	confirm.	To	tap	all	the	attachments	from	a	conversation,	open	the	conversation	and	tap	your	contact’s	name	at	the	top.	Go
to	the	Photos	section,	tap	See	All,	and	tap	Select.	Tap	attachments	to	select	them,	then	tap	Delete.	Tap	Delete	Attachment(s)	to	confirm.	2	On	a	Mac.	You	can	also	delete	messages	from	the	Messages	app	on	Mac	if	you	have	Messages	in	iCloud	enabled.	To	delete	an	individual	message	or	attachment,	Control-click	the	text	bubble	or	attachment	and
click	Delete….	Click	Delete	again	to	confirm.	To	delete	a	whole	conversation,	Control-click	the	conversation	in	the	left	sidebar,	then	select	Delete….	Click	Delete	again	to	confirm.	To	delete	all	the	messages	in	a	conversation,	open	the	conversation	and	click	the	i	button	in	the	top	right	corner.	Scroll	down	to	Photos	and	select	one	or	more	photos.
Control-click	and	select	Delete,	then	click	Delete	Attachment(s).	Advertisement	1	On	an	iOS	device.	If	you	have	iCloud	email	set	up,	you	can	delete	emails	from	iCloud	by	deleting	them	from	your	devices.	If	you	want	to	keep	a	backup	of	your	emails,	you	can	export	your	mailbox	to	your	Mac	before	deleting	messages.	To	delete	messages:[4]	Open	the
Mail	app	on	your	iPhone,	iPad,	or	Apple	Vision	Pro.	Swipe	left	on	an	email	and	select	More	>	Trash	Message.	Tap	Mailboxes	at	the	top	of	the	screen	and	go	to	Trash.	If	you	don’t	see	Trash	in	your	list	of	mailboxes,	tap	Edit	in	the	top	right	corner,	then	select	Trash	from	the	list	of	preset	mailboxes	and	tap	Done.	You	might	have	to	tap	Add	Mailbox…	to
find	Trash.	Swipe	all	the	way	left	on	a	message	to	delete	it.	You	can	also	tap	Edit	>	Select	All	>	Delete	>	Delete	All	to	empty	your	Trash.	2	On	a	Mac.	To	delete	iCloud	mail	from	your	Mac:	Open	the	Mail	app.	Select	any	email	messages	you	want	to	delete,	then	click	the	Delete	icon	(which	looks	like	a	trash	can)	at	the	top	right	side	of	the	Mail	window.
Click	Mailbox	in	the	menu	bar	at	the	top	of	the	screen,	then	select	Erase	Deleted	Items.	If	you	have	more	than	one	email	account	associated	with	your	Mail	app,	you’ll	be	prompted	to	select	one	or	all	of	them.	Click	Erase	to	confirm	your	choice.	You	can	also	go	to	the	Trash	mailbox	for	your	iCloud	account	in	the	sidebar,	then	delete	individual	emails
from	there.	3	On	a	Windows	PC.	If	you	have	an	iCloud	account	connected	to	Microsoft	Outlook,	you	can	simply	delete	the	emails	from	Outlook	to	erase	them	from	your	iCloud	account.	They’ll	be	permanently	deleted	next	time	you	restart	Outlook.	4	On	iCloud	for	the	web.	On	any	device,	go	to	and	sign	in	with	your	Apple	ID.	Once	you’re	logged	in,	click
the	Mail	icon.	Select	the	message(s)	you	want	to	delete	and	click	the	Trash	icon	on	the	top	right	side	of	the	window.	5	Recover	any	deleted	emails	within	30	days.	If	you	change	your	mind	about	deleting	an	email,	simply	go	to	your	Trash	mailbox,	select	the	email	you	want	to	recover,	and	tap	or	click	the	icon	that	looks	like	a	folder	to	move	it	to	a
different	mailbox.	Emails	in	the	trash	are	automatically	deleted	after	30	days.	To	delete	them	faster,	select	the	email	and	click	or	tap	the	Trash	icon.	Advertisement	1	On	an	iOS	device.	If	you	have	Voice	Memos	connected	to	iCloud,	you	can	delete	old	voice	memos	from	the	cloud	by	deleting	them	on	your	device.[5]	Open	the	Voice	Memos	app	on	your
iPhone,	iPad,	or	Apple	Vision	Pro,	then	tap	Edit.	Tap	any	voice	memos	you	want	to	delete	to	select	them.	Tap	the	Delete	button.	Tap	the	<	icon	to	go	to	the	main	menu,	then	select	Recently	Deleted.	Tap	Edit	and	select	any	recordings	you’re	ready	to	permanently	delete.	Tap	Delete	Forever	to	confirm.	Otherwise,	wait	30	days,	and	the	recordings	will	be
deleted	automatically.	2	On	a	Mac.	Launch	the	Voice	Memos	app,	then	click	any	recordings	you	want	to	delete	on	the	left	side	of	the	window.	Click	the	Trash	icon	at	the	top	right	side	of	the	window	to	delete	them.	You	may	see	a	popup	the	first	time	you	do	this	telling	you	that	your	recording	is	being	moved	to	Recently	Deleted.	Click	OK	to	confirm.	To
permanently	delete	a	recording	immediately,	click	Recently	Deleted	in	the	sidebar	menu.	You	might	have	to	go	to	View	>	Show	Sidebar	to	see	it.	Select	a	recording	and	click	Delete,	or	click	Delete	All	at	the	bottom	of	the	list	of	recordings.	Click	Delete	Forever	to	confirm.	You	can	also	recover	recently	deleted	recordings	from	the	same	menu.	If	you
don’t	do	anything,	they’ll	be	automatically	deleted	after	30	days.	Advertisement	1	On	an	iOS	device.	If	you	have	iCloud	Backups	enabled,	you	can	delete	old	backups	to	free	up	space.	To	do	this	on	an	iPhone,	iPad,	or	Apple	Vision	Pro:[6]	Open	Settings	>	[your	name]	>	iCloud.	Tap	Manage	Account	Storage	or	Manage	Storage,	then	tap	Backups.	Tap
the	device	for	which	you	want	to	delete	backups.	Tap	Delete	Backup	then	Turn	Off	&	Delete	to	confirm.	For	some	devices,	you	might	see	an	option	to	Turn	Off	&	Delete	from	iCloud	instead	of	Delete	Backup.	In	some	cases,	you	may	also	be	able	to	turn	off	and	delete	backups	for	specific	apps	from	this	menu.	This	will	turn	off	iCloud	backup	for	the
selected	device.	You	can	go	back	into	Settings	on	that	device	to	turn	it	back	on.	2	On	a	Mac.	On	a	Mac,	you	can	delete	iCloud	backups	from	System	Settings.	Click	the	Apple	menu	and	select	System	Settings	(or	System	Preferences).	Click	your	name	at	top	left,	then	click	iCloud	in	the	main	window.	Next	to	the	Account	Storage	header,	click	Manage…,
then	click	Backups	in	the	pop-up	window.	Select	the	device	for	which	you	want	to	delete	the	backup,	then	click	the	—	button	at	the	bottom	of	the	list	to	delete	it.	Click	Delete	to	confirm.	3	On	a	Windows	PC.	If	you	have	the	iCloud	for	Windows	app,	you	can	use	it	to	delete	unwanted	backups.	Launch	the	app	and	sign	in	with	your	Apple	ID.	Then:
Advertisement	Ask	a	Question	Advertisement	Thanks	Thanks	Advertisement	This	article	was	co-authored	by	wikiHow	staff	writer,	Megaera	Lorenz,	PhD.	Megaera	Lorenz	is	an	Egyptologist	and	Writer	with	over	20	years	of	experience	in	public	education.	In	2017,	she	graduated	with	her	PhD	in	Egyptology	from	The	University	of	Chicago,	where	she
served	for	several	years	as	a	content	advisor	and	program	facilitator	for	the	Oriental	Institute	Museum’s	Public	Education	office.	She	has	also	developed	and	taught	Egyptology	courses	at	The	University	of	Chicago	and	Loyola	University	Chicago.	This	article	has	been	viewed	51,497	times.	Co-authors:	3	Updated:	December	5,	2024	Views:	51,497
Categories:	ICloud	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	51,497	times.	This	tutorial	will	show	you	three	easy	ways	to	access	all	your	iCloud	Drive	images,	audio,	video,	PDF,	documents,	and	other	files	on	your	iPhone	or	iPad.	iCloud	Drive	is	an	online	storage	service	by	Apple	that	lets	you	save	files
in	the	cloud,	making	them	accessible	from	any	device.	On	top	of	that,	third-party	applications	can	save	their	data	on	iCloud	Drive.	It’s	similar	to	Google	Drive,	Microsoft	OneDrive,	Dropbox,	and	other	cloud	storage	services.	Related:	How	to	use	iCloud	and	iCloud	Drive	on	your	Mac	Set	up	iCloud	Drive	on	iPhone	or	iPad	When	setting	up	your	new	or
erased	iPhone	or	iPad,	you	most	likely	signed	in	using	your	Apple	ID.	If	you	did	that,	iCloud	Drive	is	already	active	on	our	device.	However,	if	you	turned	it	off	or	don’t	remember	setting	it	up,	follow	these	steps	to	check	and	enable	iCloud	Drive:	Open	the	Settings	app	on	your	iPhone	or	iPad.	Tap	your	name	from	the	top.	If	you	have	not	signed	in	to
your	Apple	ID,	do	that	first.	Tap	iCloud	>	iCloud	Drive.	Turn	on	Sync	this	iPhone/iPad.	Alternatively,	you	can	also	open	the	Files	app	and	tap	Browse	>	iCloud	Drive	>	Turn	on	iCloud	Drive	>	Sync	this	iPhone.	Related:	How	to	get	iCloud	on	iPhone,	iPad,	Mac,	or	Windows	PC	Once	iCloud	Drive	is	set	up,	you	can	access	its	files	inside	the	iOS	Files	app	or
other	third-party	apps.	3	ways	to	access	your	files	stored	in	iCloud	Drive	on	iPhone	or	iPad	The	first	method	is	the	best,	but	depending	on	the	situation,	you	can	use	the	other	two	as	well.	1.	From	the	Files	app	The	Apple	Files	app	comes	preinstalled	on	all	recent	versions	of	iOS.	You	can	access	your	local	files,	as	well	as	those	from	iCloud	Drive	or	other
third-party	services	like	Google	Drive,	Dropbox,	OneDrive,	Box,	etc.	Open	the	Files	app	on	your	iPhone	or	iPad.	Tap	Browse.	Select	iCloud	Drive	to	access	your	files.	Can’t	see	iCloud	Drive	in	the	Files	app?	Open	the	Files	app	and	go	to	the	Browse	section.	From	here,	tap	the	more	button	>	Edit	>	enable	iCloud	Drive,	and	hit	Done.	2.	From	iCloud	web
You	can	log	in	to	iCloud	and	access	your	iCloud	Drive	files	from	your	iPhone,	iPad,	Mac,	Windows	PC,	or	Android	phone.	Here’s	how:	Tip:	You	cannot	upload	new	files	to	iCloud	Drive	from	the	Recents	section	of	a	web	browser,	which	opens	by	default	after	you	access	iCloud	Drive	on	the	web.	So,	go	to	the	Browse	section	to	see	the	upload	button.	3.
From	inside	third-party	apps	Several	third-party	apps	can	open	the	Files	app	interface	inside	it	and	let	you	see	your	data	there	and	import	them.	Here’s	how	to	do	that	using	the	popular	Documents	app:	Open	the	Documents	app	on	your	iPhone	or	iPad.	Tap	Files.	Select	iCloud	Drive	under	the	Locations	heading.	From	here,	you	can	tap	a	file	to	open	it
in	that	third-party	app.	Other	iCloud	Drive	tutorials:	Tags	Files	How	to	iCloud	iCloud	Drive	iPad	iPhone	Tutorial	Page	content	loaded	Feb	1,	2022	2:17	PM	in	response	to	Susan	Winsor	Go	to	www.icloud.com	and	log	in	using	your	Apple	ID	and	password.	Assuming	you	are	syncing	your	files	to	iCloud,	you	should	find	them	by	clicking	on	the	icon	"iCloud
Drive".Add	your	Desktop	and	Documents	files	to	iCloud	Drive	-	Apple	Support	Feb	1,	2022	2:35	PM	in	response	to	Susan	Winsor	What	Idris	said,	or	create	an	account	for	yourself	on	the	desktop	mac	and	set	it	up	to	connect	to	your	Apple	id,	and	access	your	iCloud	Drive	just	as	you	do	in	your	mac.	People	seem	to	forget	or	not	realize	that	macOS	is	a
multi-user	OS		Feb	1,	2022	4:44	PM	in	response	to	Luis	Sequeira1	What	Luis	said,	or	create	a	shared	iCloud	folder	giving	your	husband's	account	the	privilege	to	make	changes	to	your	files.-	Pie	Lover	Feb	2,	2022	6:22	AM	in	response	to	Luis	Sequeira1	Luis	Sequeira1	wrote:What	Idris	said,	or	create	an	account	for	yourself	on	the	desktop	mac	and	set
it	up	to	connect	to	your	Apple	id,	and	access	your	iCloud	Drive	just	as	you	do	in	your	mac.	People	seem	to	forget	or	not	realize	that	macOS	is	a	multi-user	OS	Excellent	point,	Luis!	I	know	I	don't	think	of	it	as	I	live	alone	and	no	one	else	ever	uses	my	computer.	You	can	view	files	and	folders	stored	in	iCloud	Drive	using	a	web	browser.Go	to
icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	an	option	in	the	sidebar,	such	as	Recents	or	Browse.If	you	don’t	see	the	sidebar,	click	.To	open	a	folder,	double-click	it.To	view	a	file,	do	one	of	the	following:Open	it	in	a	new	tab:	Double-click	it.See	a	preview	in	your	current	tab:	Select	it,	click	in	the	top-right	corner,	then
choose	Preview.	If	the	file	doesn’t	have	a	thumbnail,	you	can’t	see	a	preview.Tip:	You	can	also	select	the	file,	then	press	the	Space	bar.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	or	in	the	top-left	corner	(depending	on	your	current	view).Choose	an	option:Grid:	Files	and	folders	are	shown	as	icons	arranged	in	a
grid.List:	Files	and	folders	are	arranged	by	name	in	a	list,	and	other	columns	show	additional	information.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	the	“Sort	by”	menu	in	the	top-right	corner,	then	choose	Date,	Kind,	Name,	or	Size.If	you	don’t	see	the	“Sort	by”	pop-up	menu,	make	sure	you’re	not	viewing	the
Recents	folder.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Select	the	file	or	folder,	click	in	the	top-right	corner,	then	click	Details.The	information	includes	the	file	type,	its	size,	when	it	was	last	modified,	and	where	it’s	stored.	If	the	file	is	shared,	you	can	also	see	who	shared	it.Learn	how	to	use	iCloud	Drive	on
iCloud.com	on	a	phone	or	tablet.	You	can	view	files	and	folders	stored	in	iCloud	Drive	using	a	web	browser.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	an	option	in	the	sidebar,	such	as	Recents	or	Browse.If	you	don’t	see	the	sidebar,	click	.To	open	a	folder,	double-click	it.To	view	a	file,	do	one	of	the
following:Open	it	in	a	new	tab:	Double-click	it.See	a	preview	in	your	current	tab:	Select	it,	click	in	the	top-right	corner,	then	choose	Preview.	If	the	file	doesn’t	have	a	thumbnail,	you	can’t	see	a	preview.Tip:	You	can	also	select	the	file,	then	press	the	Space	bar.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	or	in
the	top-left	corner	(depending	on	your	current	view).Choose	an	option:Grid:	Files	and	folders	are	shown	as	icons	arranged	in	a	grid.List:	Files	and	folders	are	arranged	by	name	in	a	list,	and	other	columns	show	additional	information.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Click	the	“Sort	by”	menu	in	the	top-
right	corner,	then	choose	Date,	Kind,	Name,	or	Size.If	you	don’t	see	the	“Sort	by”	pop-up	menu,	make	sure	you’re	not	viewing	the	Recents	folder.Go	to	icloud.com/iclouddrive,	then	sign	in	to	your	Apple	Account	(if	necessary).Select	the	file	or	folder,	click	in	the	top-right	corner,	then	click	Details.The	information	includes	the	file	type,	its	size,	when	it
was	last	modified,	and	where	it’s	stored.	If	the	file	is	shared,	you	can	also	see	who	shared	it.Learn	how	to	use	iCloud	Drive	on	iCloud.com	on	a	phone	or	tablet.	You	can	access	your	files,	photos,	mail,	notes,	and	other	data	on	any	device	by	signing	in	to	.	Once	you	enable	iCloud	syncing	on	your	Mac,	you	can	view	photos	in	the	Photos	app,	and	your
iCloud	Drive	files	in	Finder.	If	you	modify	or	delete	a	file	on	iCloud	from	one	of	your	devices,	the	change	will	take	effect	everywhere	you	use	iCloud.	1	Open	the	Files	app	on	your	iPhone	or	iPad.	You	can	use	the	Files	app	to	access	any	of	the	files	you've	saved	to	your	iCloud	Drive.	You'll	find	Files	on	the	Home	screen,	in	the	App	Library,	or	by
searching.[1]	If	you're	looking	for	your	iCloud	Photos,	you'll	find	them	in	the	Photos	app.	If	you	haven't	already	set	up	iCloud	syncing	on	your	iPhone	or	iPad,	see	this	method.	2	Tap	Browse.	You'll	see	this	option	at	the	bottom	of	Files.	This	tapes	you	to	the	Browse	screen.[2]	Advertisement	3	Tap	iCloud	Drive.	It'll	be	at	the	top	of	the	folder	list	under
"Locations."	This	displays	all	of	the	files	and	folders	you've	saved	to	your	iCloud	Drive.	Advertisement	1	Open	Finder	on	your	Mac	.	It's	the	two-toned	smiley	face	icon	on	the	Dock.[3]	To	see	the	photos	you've	synced	to	iCloud	from	other	devices,	just	open	the	Photos	app	on	your	Mac.	2	Click	iCloud	Drive	in	the	left	panel.	This	displays	all	of	the	files
and	folders	you've	saved	to	your	iCloud	Drive.[4]	If	you	don't	see	iCloud	Drive,	see	this	method	to	set	up	iCloud	syncing	on	your	Mac.	You	can	also	access	your	iCloud	Drive	files	in	a	terminal	using	Linux	commands.	Advertisement	1	Go	to	the	in	your	web	browser	and	click	Sign	In.	If	you	want	an	easy	way	to	access	your	iCloud	Photos,	Mail,	and	other
data	while	you're	away	from	your	primary	Mac,	iPhone,	or	iPad,	you'll	love	iCloud	on	the	web.	You	can	sign	in	to	the	web-based	version	of	iCloud	from	any	device—even	your	Android	or	Windows	PC.[5]	If	you're	using	Windows,	you	can	opt	to	install	the	iCloud	for	Windows	app	from	the	Microsoft	Store	if	you	want	to	automatically	sync	files	to	and	from
your	PC	instead.	See	this	wikiHow	guide	to	learn	how!	If	you	just	want	to	access	your	iCloud	files	and	don't	want	to	sync,	accessing	on	the	web	is	the	simplest	way	to	get	to	your	files,	as	well	as	upload	new	ones.	2	Enter	your	Apple	ID	and	password	to	sign	in.	To	access	your	iCloud	information,	you'll	need	to	sign	into	your	account.[6]	After	entering
your	email	address,	click	the	arrow,	then	enter	your	password	to	sign	in.	3	Confirm	your	identity	with	two-step	authentication.	If	two-step	authentication	is	enabled	on	your	account,	you	will	receive	a	code	on	your	primary	device,	which	could	be	your	iPhone,	iPad,	or	Mac.	Tap	or	click	the	notification	you	receive	on	your	primary	device,	then	tap	Allow
to	see	the	code.	Type	the	code	into	the	field	in	your	web	browser	to	sign	in.	Click	Trust	if	you're	using	your	own	personal	device	and	want	to	give	it	permission	to	access	iCloud.	4	Access	your	photos	in	the	Photos	app.	You'll	see	the	Photos	app	icon	near	the	bottom-left	corner	of	the	main	iCloud	page,	as	well	as	in	the	menu	at	the	top-right	corner.	Now
you	can	see	all	of	the	photos	you've	synced	to	from	your	devices,	including	your	iPhone	or	iPad.[7]	5	Access	your	iCloud	email	in	the	Mail	app.	If	you	want	to	check	your	iCloud	email	when	you're	away	from	your	iPhone,	iPad,	or	Mac,	you	can	do	so	in	the	Mail	app	on	iCloud.	Just	click	Mail	at	the	top	of	the	page,	or	click	the	menu	icon	at	the	top-right
and	choose	the	Mail	app	to	access	your	inbox.[8]	6	Access	your	iCloud	Drive	files	in	the	Drive	app.	Any	files	you've	synced	to	your	iCloud	Drive	from	other	devices	will	be	available	in	the	Drive	app	on	this	page.	You	can	also	add	new	files	to	iCloud	Drive	here.	Click	and	drag	any	documents	you	wish	to	save	onto	the	Drive	screen.	Now	your	documents
will	be	available	from	any	synced	device,	including	an	iPhone	or	iPad.	7	Access	other	data	on	iCloud.	Click	the	menu	icon	at	the	top-right	to	explore	all	of	the	different	apps	and	files	you	can	work	with	using	iCloud	on	the	web.	You	can	view	and	manage	your	Calendar,	access	your	Contacts,	see	and	create	Reminders,	and	even	use	web-based	versions
of	apps	like	Pages,	Numbers,	and	Keynote.[9]	Advertisement	1	Open	your	iPhone	or	iPad's	Settings.	You'll	find	it	on	your	Home	screen	or	in	your	App	Library.	Once	you	enable	iCloud	syncing	in	iOS,	you	can	easily	access	all	of	your	iCloud	Drive	files,	iCloud	Photos,	and	other	synced	data.[10]	2	Tap	your	name.	It's	at	the	top	of	the	menu.[11]	If	you	are
not	signed	in,	tap	Sign	in	to	(Your	Device),	enter	your	Apple	ID	and	password,	then	tap	Sign	In.	3	Tap	iCloud.	It's	in	the	second	section.[12]	4	Select	the	types	of	data	you	wish	to	store	on	iCloud.	Enabling	iCloud	for	these	apps	and	data	types	ensures	you'll	have	access	to	the	same	files	anywhere	you	sign	in	with	your	Apple	ID.	To	sync	your	photos,	tap
Photos,	and	then	tap	the	"Sync	this	iPhone"	(or	"Sync	this	iPad")	switch.	Syncing	your	photos	makes	all	of	the	photos	on	your	iPhone	or	iPad	available	anywhere	you	sign	in	to	iCloud,	including	your	Mac,	PC,	and	on	the	web.	To	keep	the	files	on	your	iPhone	or	iPad	synced	to	your	iCloud	Drive	so	you	can	access	them	anywhere,	tap	iCloud	Drive,	and
then	tap	Sync	this	iPhone	(or	Sync	this	iPad).	This	option	also	makes	it	possible	to	access	your	iCloud	Drive	files	in	the	Files	app.	To	use	your	iCloud	email	address	in	the	Mail	app,	tap	iCloud	Mail,	and	then	enable	"Use	on	this	iPhone"	(or	iPad).	To	keep	your	passwords	synced	across	your	devices,	tap	Passwords	and	Keychain,	and	then	tap	"Sync	this
iPhone"	(or	iPad).	You	can	tap	Show	All	to	see	additional	apps	and	data	types	capable	of	syncing	to	iCloud.	5	Scroll	down	and	tap	iCloud	Backup	to	back	up	your	iPhone	or	iPad	to	iCloud.	It's	in	the	"DEVICE	BACKUPS"	section.	If	you	don't	see	this	option,	tap	<	iCloud	at	the	top-left	to	go	back	one	screen.	To	set	up	automatic	backups	to	iCloud,	tap	the
switch	next	to	"Back	Up	This	iPhone"	(or	iPad).	To	start	your	first	backup,	tap	Back	Up	Now.	Advertisement	1	Open	your	Mac's	System	Preferences.	You'll	find	this	option	in	the	Apple	menu	at	the	top-left	corner.	Once	you	enable	iCloud	syncing,	you'll	be	able	to	access	your	iCloud	data,	including	photos	and	files	in	your	iCloud	Drive,	on	your	Mac.	2
Click	Apple	ID.	It's	near	the	top	of	the	window.[13]	If	you	see	Sign	In,	click	that	option	and	log	in	with	your	Apple	ID.[14]	3	Click	iCloud.	You'll	see	this	option	in	the	left	panel.	Now	you'll	see	the	option	to	enable	or	disable	iCloud	Drive,	as	well	as	turn	on	iCloud	for	other	apps	and	data	on	your	Mac.[15]	4	Check	the	box	next	to	"iCloud	Drive"	to	sync	the
files	on	your	iCloud	Drive	to	and	from	your	Mac.	Once	you've	enabled	this	feature,	all	of	your	files	in	iCloud	will	sync	to	your	Mac,	which	allows	you	to	access	them	in	Finder.[16]	To	view	your	iCloud	Drive	files	on	your	Mac,	open	Finder,	then	click	the	iCloud	Drive	option	in	the	left	panel.	5	Click	Options	to	choose	which	files	to	sync	to	your	iCloud
Drive.	This	button	is	to	the	right	of	"iCloud	Drive"	at	the	top	of	the	window.[17]	6	Select	files	to	sync	to	your	iCloud	Drive.	Syncing	files	automatically	to	your	iCloud	Drive	is	a	great	way	to	keep	your	important	files	safely	stored	in	the	cloud.	If	you	want	the	files	you	save	to	your	Mac's	desktop	and	your	Documents	folder	to	stay	synced	to	iCloud	so	you
can	access	them	anywhere,	check	the	box	next	to	"Desktop	&	Documents	Folders."	Scroll	down	to	view	all	apps	and	data	that	you	can	sync	to	iCloud.	Checking	the	box	next	to	these	apps	and	data	types	ensures	they'll	stay	synced.	Click	Done	when	you're	finished.	7	Choose	which	other	types	of	data	to	sync	to	iCloud.	In	the	"Apps	on	this	Mac	using
iCloud"	section,	check	the	boxes	next	to	each	type	of	data	you	want	to	keep	synced	to	iCloud.	This	includes	Calendar,	Mail,	Contacts,	and	even	your	Safari	data.	To	sync	the	photos	on	your	Mac	to	iCloud,	check	the	box	next	to	"Photos."	This	also	syncs	iCloud	photos	from	your	other	devices	to	your	Mac	so	they'll	be	available	in	the	Photos	app.	Most
options	are	selected	by	default	to	ensure	a	seamless	experience	across	all	of	your	devices.	8	Access	your	iCloud	files.	Now	that	you've	enabled	iCloud,	it's	easy	to	find	your	files:	Advertisement	Add	New	Question	Question	How	do	I	set	up	iCloud	on	my	phone?	Josef	Storzi	Apple	&	Mobile	Phone	Repair	Specialist	Josef	Storzi	is	an	Apple	and	Mobile
Phone	Repair	Specialist	and	the	Owner	of	Imobile	LA,	a	mobile	phone	repair	company	based	in	Los	Angeles,	California.	Josef	specializes	in	repairing	screens,	charging	ports,	batteries,	water	damage,	speakers,	and	microphones	on	all	mobile	phone	brands	including	Apple,	Samsung,	LG,	Nokia,	and	Sony.	He	also	specializes	in	tablet,	laptop,	and
computer	repairs	as	well	as	the	pros	and	cons	of	recent	mobile	software	updates.	On	an	iDevice,	there's	a	section	for	iCloud	in	your	Settings	menu.	Here,	you	can	see	all	the	data	that's	being	synced	and	backed	up.	It	also	gives	you	the	option	to	turn	individual	items	on	or	off.	Question	How	do	I	get	to	iCloud	on	a	PC?	Josef	Storzi	Apple	&	Mobile	Phone
Repair	Specialist	Josef	Storzi	is	an	Apple	and	Mobile	Phone	Repair	Specialist	and	the	Owner	of	Imobile	LA,	a	mobile	phone	repair	company	based	in	Los	Angeles,	California.	Josef	specializes	in	repairing	screens,	charging	ports,	batteries,	water	damage,	speakers,	and	microphones	on	all	mobile	phone	brands	including	Apple,	Samsung,	LG,	Nokia,	and
Sony.	He	also	specializes	in	tablet,	laptop,	and	computer	repairs	as	well	as	the	pros	and	cons	of	recent	mobile	software	updates.	Navigate	to	iCloud.com	in	your	browser	and	sign	into	your	iCloud	account.	From	there,	you'll	see	all	of	the	data	from	your	iDevice	that	has	been	synced	to	iCloud.	Question	How	do	I	take	photos	off	of	iCloud?	Sign	into	your
iCloud	and	go	to	"Photos."	Click	"Select,"	then	click	on	the	photos	you	don't	want	anymore.	Once	oyu	have	them	selected,	click	"Delete."	Alternatively,	you	could	also	delete	the	photos	one	by	one	if	the	select	option	is	not	there	See	more	answers	Ask	a	Question	Advertisement	Thanks	Thanks	Thanks	The	advice	in	this	section	is	based	on	the	lived
experiences	of	wikiHow	readers	like	you.	If	you	have	a	helpful	tip	you’d	like	to	share	on	wikiHow,	please	submit	it	in	the	field	below.	When	your	iCloud	storage	starts	filling	up,	check	your	Settings	to	see	what's	taking	up	the	most	space	and	delete	any	old	files	you	don't	need	anymore.	Use	another	backup	service	like	Google	Drive	or	Dropbox	in
addition	to	iCloud	so	you	have	multiple	copies	of	your	files.	Advertisement	Co-authored	by:	Apple	&	Mobile	Phone	Repair	Specialist	This	article	was	co-authored	by	Josef	Storzi	and	by	wikiHow	staff	writer,	Nicole	Levine,	MFA.	Josef	Storzi	is	an	Apple	and	Mobile	Phone	Repair	Specialist	and	the	Owner	of	Imobile	LA,	a	mobile	phone	repair	company
based	in	Los	Angeles,	California.	Josef	specializes	in	repairing	screens,	charging	ports,	batteries,	water	damage,	speakers,	and	microphones	on	all	mobile	phone	brands	including	Apple,	Samsung,	LG,	Nokia,	and	Sony.	He	also	specializes	in	tablet,	laptop,	and	computer	repairs	as	well	as	the	pros	and	cons	of	recent	mobile	software	updates.	This	article
has	been	viewed	2,297,843	times.	Co-authors:	38	Updated:	December	18,	2024	Views:	2,297,843	Categories:	Featured	Articles	|	Apple	iOS	|	ICloud	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	2,297,843	times.	How	To	Posted	on	May	30th,	2022	by	Kirk	McElhearn	If	you	use	a	Mac,	iPhone,	or	iPad,	you
can	store	files	in	iCloud	Drive,	Apple’s	cloud	storage	service.	This	is	just	one	of	the	many	iCloud	features	available,	ranging	from	privacy	and	backups	to	cloud	sync	of	your	photos	and	music	library.	iCloud	Drive	is	especially	useful	if	you	have	two	Macs;	you	can	sync	your	Desktop	and	Documents	folders	to	iCloud	Drive,	so	you	can	easily	switch
between	working	on	a	desktop	Mac	and	a	laptop.	And	you	can	even	access	these	files	on	your	iPhone	or	iPad.	In	this	article,	I’ll	explain	how	iCloud	Drive	works,	and	tell	you	how	you	can	get	the	most	out	of	this	service.	Understanding	iCloud	Drive	storage	When	you	buy	an	Apple	device,	you	get	5	GB	iCloud	storage.	You	don’t	get	more	if	you	have
multiple	devices,	and,	for	most	people,	this	5	GB	is	paltry.	If	only	to	back	up	an	iPhone	and	store	some	photos	in	the	cloud,	you	quickly	use	it	up.	Apple	has	always	sold	multiple	tiers	of	iCloud	storage,	and	the	current	offer	is	the	following:	50	GB:	$0.99	per	month	200	GB:	$2.99	per	month	2	TB:	$9.99	per	month	Apple	now	calls	any	storage	plan
iCloud+,	because	it	includes	some	new	security	and	privacy	features.	You	can	use	iCloud	Private	Relay,	Hide	My	Email,	HomeKit	Secure	Video,	and	you	can	host	your	own	domain	for	email.	See	How	to	Use	iCloud+,	with	Additional	Security	and	Privacy	Features,	and	More.	If	you	only	use	iCloud	Drive	to	store	a	handful	of	files,	the	50	GB	tier	is
probably	sufficient.	Remember,	though,	that	this	iCloud	storage	is	shared	with	all	the	other	iCloud	services,	and,	for	many	people,	the	Photos	library	takes	up	most	of	the	space.	Here’s	my	current	iCloud	drive	storage	(you	can	see	this	in	System	Preferences	>	Apple	ID	on	Mac,	or	in	Settings	>	Apple	ID	>	iCloud	on	an	iPhone	or	iPad):	You	can	see	that
I	have	used	more	than	half	of	my	200	GB,	and	that	photos	take	up	about	a	third	of	my	total	storage,	and	documents	about	a	quarter.	How	does	iCloud	Drive	work?	iCloud	Drive	works	like	other	cloud	storage	services,	such	as	Dropbox	or	OneDrive.	On	a	Mac,	there	is	an	iCloud	Drive	folder,	to	which	you	can	add	folders	and	files.	You’ll	find	iCloud	Drive
in	the	Finder	sidebar,	in	the	iCloud	section.	Any	app	for	Mac,	iPhone,	or	iPad	can	store	files	on	iCloud	Drive,	and	you	will	see	folders	for	these	apps.	Here	are	some	of	the	folders	in	my	iCloud	Drive:	Some	of	these	are	apps	that	are	available	for	Mac,	iPhone,	and	iPad	–	such	as	Apple’s	Keynote,	Numbers,	and	Pages	–	and	some	are	only	iOS/iPadOS	apps.
You	can	open	these	files	either	from	the	Finder,	or	the	apps	themselves;	on	an	iPhone	or	iPad,	you	can	open	them	from	the	apps,	or,	in	some	cases,	from	the	Files	app.	(See	below.)	If	you	want	to	make	a	file	on	your	Mac	available	to	an	iPhone	or	iPad	app,	via	iCloud	Drive,	you	can	just	drop	it	into	that	app’s	folder.	You	can	also	save	a	file	to	iCloud
Drive,	or	move	a	file	that	you	saved	on	the	Mac	to	iCloud	Drive.	How	to	use	the	Files	app	on	iPhone	and	iPad	The	Files	app	lets	you	access	files	in	iCloud	Drive	on	an	iPhone	or	iPad.	When	you	open	the	app,	you’ll	see	locations	–	iCloud	Drive,	On	My	iPhone	/	iPad,	Shared,	and	Recently	Deleted.	You	may	also	see	other	locations;	if	you	tap	…,	then	Edit,
you	can	see	toggles	for	other	cloud	services	whose	apps	are	on	your	device.	You	can	tap	iCloud	Drive,	and	navigate	the	folders	it	contains,	or	type	part	of	a	file	name	into	the	search	field.	In	some	cases,	you	can	see	files	but	not	open	them;	this	will	be	the	case	if	you	store	files	from	your	Mac	in	iCloud	Drive,	and	there	are	no	equivalent	apps	for	iOS	/
iPadOS.	How	to	save	files	to	iCloud	Drive	When	saving	a	file	on	a	Mac,	click	the	Where	menu,	and	choose	one	of	the	two	iCloud	Library	options.	You	can	save	to	the	Numbers	folder	in	iCloud,	or,	if	you	choose	iCloud	Drive,	you	can	navigate	to	a	specific	folder.	You	will	want	to	do	this	if	you’re	saving	a	file	to	a	shared	folder,	for	example.	You	can	also
move	files	from	the	Finder	to	iCloud	Drive,	and	vice	versa.	Open	a	file,	then	choose	File	>	Move	To,	and	choose	where	to	move	the	file.	The	dialogue	is	similar	to	that	above.	On	an	iPhone	or	iPad,	apps	that	save	files	will	do	so	either	to	their	own	cloud	storage,	if	any,	or	to	iCloud	Drive.	How	to	open	files	from	iCloud	Drive	The	way	you	open	files	from
iCloud	Drive	depends	on	the	app.	On	the	Mac,	apps	like	Keynote,	Numbers,	and	Pages	launch	with	an	Open	dialogue,	which	will	either	show	the	last	used	folder,	on	the	app’s	iCloud	Drive	folder	in	the	Finder	sidebar.	For	other	apps,	you	can	navigate	to	the	app’s	folder	in	iCloud	Drive,	then	double-click	a	file.	If	you’ve	already	worked	on	a	file,	launch
an	app,	then	choose	File	>	Open	Recent,	and	select	the	file.	On	iOS	or	iPad	OS,	since	you	don’t	directly	have	access	to	the	file	system,	you	can	open	files	when	launching	an	app;	different	apps	have	different	ways	of	accessing	files	in	iCloud.	Or	you	can	use	the	Files	app	to	find	the	file	you	want	to	work	with,	and	tap	it	to	open	it.	How	to	sync	files	and
folders	across	Macs	One	key	feature	of	iCloud	Drive	is	the	ability	to	sync	the	content	of	your	Mac’s	Desktop	and	Documents	folder	to	iCloud.	You’ll	see	this	option	when	setting	up	a	new	Mac,	but	you	can	manually	enable	it	if	you	haven’t	already.	This	has	several	benefits.	If	you	work	on	two	Macs	–	a	desktop	Mac	and	a	laptop	–	then	you	can	switch
seamlessly	from	one	to	the	other,	as	long	as	you	have	the	bandwidth	for	files	to	sync.	It	also	means	that	all	these	files	are	easily	accessible	on	an	iPhone	or	iPad,	via	the	Files	app,	and	you	can	even	access	them	via	icloud.com.	To	enable	this,	go	to	System	Preferences	>	Apple	ID,	then	click	iCloud	in	the	sidebar.	Next	to	iCloud	Drive,	click	Options.	You
see	a	list	of	apps	that	store	documents	in	iCloud,	and	you	can	uncheck	any	that	you	don’t	want	to	store	files	there.	If	you	check	Desktop	&	Documents	Folders,	then	check	Done,	your	Mac	will	start	sending	these	files	to	the	cloud.	Before	you	start	this,	make	sure	you	have	enough	storage	on	iCloud	Drive.	If	you	have	large	files	that	you	don’t	want	to	put
on	iCloud	Drive,	or	don’t	need	to	sync,	then	you	should	move	them	from	your	Documents	folder.	Create	a	new	folder	(or	folders)	for	these	files	at	the	top	level	of	your	home	folder	(the	one	with	the	house	icon	and	your	name).	For	example,	if	you	use	virtual	machines	to	run	Windows	or	Linux	on	your	Mac,	these	files	can	be	several	dozens	of	gigabytes.
You	may	not	have	enough	storage	(unless	you	have	the	2	TB	plan),	or	you	may	not	need	them	on	more	than	one	Mac.	Also,	they	take	a	long	time	to	sync,	so	when	you	finish	working	with	them,	you	need	to	make	sure	your	Mac	doesn’t	go	to	sleep.	In	addition	to	storing	your	own	files	and	accessing	them	on	your	other	devices,	you	can	share	folders	and
files	that	are	on	your	iCloud	Drive.	To	share	an	item,	right-click	on	a	folder	or	file	in	your	iCloud	Drive,	then	choose	Share	>	Share	Folder.	You	see	a	number	of	options:	When	you	share	an	iCloud	Drive	item,	you	send	a	link	to	someone	who	can	then	access	it.	You	can	send	this	link	via	Mail,	Messages,	AirDrop,	or	you	can	copy	the	link	to	send	another
way.	(For	some	reason,	other	apps	that	appear	in	the	macOS	share	sheet	show	up	here,	such	as	Deliveries	and	Twitterrific	in	my	screenshot.)	There	are	other	sharing	options:	Who	can	access:	if	you	choose	People	you	invite,	only	those	people	you	invite	directly	can	access	the	item.	Click	the	menu	to	choose	Anyone	with	the	link	to	make	the	item
available	to	anyone.	You	might	want	to	do	this	in	a	business	for	a	folder	with	shared	assets,	but	this	means	that	anyone	can	access	the	folder	and	its	contents.	Permission:	if	you	choose	Can	make	changes,	then	people	accessing	the	a	folder	will	be	able	to	add	and	delete	files,	or	delete	a	shared	file.	If	you	choose	View	only,	people	can	access	files	but
not	change	them	or	delete	them.	If	you	check	Anyone	can	add	more	people,	then	others	who	have	access	to	the	item	can	share	it	as	well.	Once	you	have	shared	folders	or	files,	they	show	up	in	the	Shared	section	of	the	Finder	sidebar.	If	you	right-click	an	item,	you	can	choose	Share	>	Manage	Shared	Folder	/	File	to	remove	access	to	the	item,	to	stop
sharing,	or	to	send	a	link	to	others.	See	this	Apple	document	for	more	on	iCloud	file	sharing,	including	how	to	access	and	manage	shared	files	and	folders	on	icloud.com.	iCloud	Drive	is	a	great	way	to	store	files	in	the	cloud,	especially	because	it’s	built	in	to	your	Apple	devices.	You	may	find	that	iCloud	Drive	is	more	practical	than	a	third-party	service,
such	as	Dropbox	or	OneDrive,	so	try	it	out	and	see	how	it	works	for	you.	How	can	I	learn	more?	Each	week	on	the	Intego	Mac	Podcast,	Intego’s	Mac	security	experts	discuss	the	latest	Apple	news,	security	and	privacy	stories,	and	offer	practical	advice	on	getting	the	most	out	of	your	Apple	devices.	Be	sure	to	follow	the	podcast	to	make	sure	you	don’t
miss	any	episodes.	You	can	also	subscribe	to	our	e-mail	newsletter	and	keep	an	eye	here	on	The	Mac	Security	Blog	for	the	latest	Apple	security	and	privacy	news.	And	don’t	forget	to	follow	Intego	on	your	favorite	social	media	channels:								About	Kirk	McElhearn	Kirk	McElhearn	has	been	writing	about	Apple	product	and	computer	security	for	more
than	25	years.	His	blog,	Kirkville,	links	to	his	work.	He	is	co-host	of	the	Intego	Mac	Podcast,	as	well	as	several	other	podcasts,	and	is	a	regular	contributor	to	The	Mac	Security	Blog,	TidBITS,	and	several	other	websites	and	publications.	Kirk	has	written	more	than	two	dozen	books,	including	Take	Control	books	about	Apple's	media	apps,	Scrivener,
and	LaunchBar.	Follow	him	on	Bluesky	at	@kirkville.com.	View	all	posts	by	Kirk	McElhearn	→	This	entry	was	posted	in	How	To	and	tagged	iCloud,	iCloud	Drive.	Bookmark	the	permalink.


